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Micro Focus Visual COBOL 2.2 Update 2 for
Eclipse Distributed Edition Release Notes

The Micro Focus Visual COBOL for Eclipse Distributed Edition package comprises the following products
which you can download from your Electronic Product Delivery Note:

• Visual COBOL for Eclipse - the product provides an Eclipse-based integrated COBOL development
environment for Windows or Linux. Visual COBOL for Eclipse provides COBOL JVM support and
enhanced compatibility with ACUCOBOL and can be used standalone for developing local applications
or in conjunction with the Visual COBOL Development Hub to develop remote projects in Linux and
UNIX.

• Visual COBOL Development Hub - the product provides a rich desktop development environment based
on the Eclipse IDE with high-performance server-based tools for managing builds, source code access
and the debugger engine. Visual COBOL Development Hub also provides a central administration site,
simplifying the development tool distribution and maintenance process.

These release notes contain information that might not appear in the Help. Read them in their entirety
before you install the product.

Note: This document contains a number of links to external Web sites. Micro Focus cannot be
responsible for the contents of the Web site or for the contents of any site to which it might link. Web
sites by their nature can change very rapidly and although we try to keep our links up-to-date, we
cannot guarantee that they will always work as expected.

Note: Visual COBOL now includes support for creating Web service and Enterprise Java Bean
applications using the Interface Mapping Toolkit (IMTK) in conjunction with Enterprise Server. If you
are upgrading to this release from an earlier version of Visual COBOL, you may need to apply for a
new authorization code in order to access the functionality - please contact Micro Focus SupportLine
to receive an updated authorization code. Note that the Visual COBOL Personal Edition license does
not support the IMTK functionality.

Important: Application executables that were compiled using earlier Micro Focus products must be
recompiled from the sources using Visual COBOL.

Micro Focus Heartbleed Update

The OpenSSL library used in this product has been updated to the latest version, 1.0.1i, to fix various
vulnerabilities.
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Installation

Installing Visual COBOL on Windows

System Requirements for Visual COBOL for Eclipse
(Windows)

Hardware Requirements
Visual COBOL has the following requirements in addition to the requirements of Eclipse. See the Eclipse
documentation for details of its requirements.

The disk space requirements are, approximately:

Platform Visual COBOL Sentinel RMS License Manager

x86 Windows platforms 1.05GB 25MB

x64 Windows platforms 1.2GB 25MB

Note: This includes the space needed to cache information locally so that you can modify the
installation without the original source media.

Operating Systems Supported
Note: You can produce 64-bit and 32-bit applications on 64-bit operating systems.

For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.

Note: The Enterprise Server feature is not supported on Windows XP.

Software requirements

Eclipse requirements

• Visual COBOL only supports the 32-bit Eclipse IDE and requires a 32-bit Java installation.
• Though Visual COBOL does not support the 64-bit Eclipse, you can use the 32-bit Eclipse to create

both 32-bit and 64-bit applications.
• Visual COBOL ships with Eclipse 3.8. After the installation, you can install the Visual COBOL plug-in

into other instances of Eclipse available on the same machine. The supported versions are 3.8, 4.2 and
4.3 for the 32-bit Eclipse only. See Installing Visual COBOL into other instances of Eclipse for
instructions.

Other software requirements

The setup file will check your machine for whether the prerequisite software is installed and will install any
missing prerequisites and the product components.

• If no Java is installed on your machine, the setup file installs Java 1.6u27 32-bit.
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• The setup file will also install .NET Framework v4.0.

If you are installing Visual COBOL on a machine that has Java 8 installed, see the Java Support in the
Known Issues and Restrictions section in your product help for considerations that apply to using the
Eclipse IDE.

Important: This release requires version 10000.2.990 or later of the Micro Focus licensing software.
For local servers, you do not need to install it separately, as the setup file installs a new Visual
COBOL client and a new licensing server on the same machine.

If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus Licensing System Administration tool. To check the version of the license server on UNIX,
run /var/microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool.sh.

You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com.

Additional Software Requirements on Windows
To ensure full functionality for some Visual COBOL features, you might be required to obtain and install
additional third-party software in addition to the prerequisite software installed automatically by the Visual
COBOL setup file. The following information specifies the third-party software required for each feature.

• Application server support for JVM COBOL on page 6
• Java Development Kit (JDK) on page 6
• Consolidated Trace Facility on page 7
• Database Access on page 7
• Database Access - COBSQL (Pro*COBOL) on page 7
• Database Access - OpenESQL on page 8
• Database Access - HCO for SQL Server (HCOSS) on page 8
• Database Access - DB2 ECM on page 9
• XML Extensions on page 10

Application server support for JVM COBOL

Back to Top

Restriction: This feature applies only when the Enterprise Server feature is enabled.

The following application servers are supported using the following JDKs:

Application Servers JDK version Containers support version

Tomcat 7.0.39 1.6 / 1.7 Servlets 2.5

JBoss 7.1.1 1.6 / 1.7 Servlets 2.5

WebLogic 12.1.1 1.6 / 1.7 Servlets 2.5

WebSphere 8.5 1.6 / 1.7 Servlets 2.5

You need Oracle's JDK. The earliest supported release of Oracle's JDK 1.6 is 1.6.027. You can download
Oracle's JDK from Oracle's Web site

Java Development Kit (JDK)

Back to Top
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Native COBOL and
Java Interoperability

Oracle's Java Platform, Enterprise Edition (Java EE) 6 or Java 7 is required to run
the Eclipse IDE, to execute COBOL JVM code and for native COBOL and Java
interoperability. The earliest supported release of Java 6 is 1.6 Update 27. You
can download Oracle's Java EE from Oracle's Web site and install it anywhere on
your machine.

Compiling Java Either the IBM or the Oracle Java Development Kit (JDK), version 1.5 or later, is
required for compiling Java.

Interface Mapping
Toolkit (IMTK)

Restriction: This feature applies only when the Enterprise Server feature
is enabled.

The JDK is required for generating Java interfaces from the Interface Mapping
Toolkit or the imtkmake command.

Java Beans Your Java client needs to be compiled with JDK 1.6 or greater.

EJBs Use the same JDK vendor and version that is used by the
application server.

After installing the JDK, you need to set up your Java environment.

Back to Top

Consolidated Trace Facility

• The Microsoft .NET Framework 2.0 or later is required for the CTF Viewer. It is available from the
Microsoft .NET downloads area.

Database Access

Back to Top

Before you can use Visual COBOL to develop and deploy SQL applications that use COBSQL, DB2 ECM,
HCO for SQL Server (HCOSS), or OpenESQL, ensure any third-party software prerequisites are installed
and the environment is set properly.

Database Access - COBSQL (Pro*COBOL)

Back to Top

Note: COBSQL (Pro*COBOL) is supported for native COBOL only.

Availability Feature/Platform 32-bit 64-bit

x86-64 running
Windows

X X

XA Switch Module When the Enterprise Server feature is enabled, the Oracle XA switch module is
provided for COBSQL (Pro*COBOL), and is available on the same platforms as
are indicated in the Availability section above.

Certification of
RDBMS
Precompilers for
Native COBOL

Certification of RDBMS precompilers with Micro Focus products is the
responsibility of the RDBMS vendor, rather than Micro Focus. Certification
information can be found within the relevant Oracle documentation. If you have an 
Oracle MetaLink account, document # 43208.1 provides details of all language
compilers certified by Oracle for use with their precompilers.

Preprocessors COBSQL supports the following database preprocessors:
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• Sybase Open Client Embedded SQL/COBOL Version 11.1 or later
• Oracle Pro*COBOL Version 11.1 (11gR1) or later
• Informix Embedded SQL/COBOL Version 7.3 or later

Compiling On x86 and x86-64 platforms, when compiling with COBSQL for use with Oracle,
do not use the COBSQL directive option NOMAKESYN, since this directive results
in COMP host variables, and on Intel platforms these are incompatible with the
native byte order expected by Oracle.

Back to Top

Database Access - OpenESQL

Availability Feature/Platform Native COBOL 32-bit Native COBOL 64-bit

x86-64 running Windows X X

XA Switch
Module

When the Enterprise Server feature is enabled, the ODBC One-phase Commit switch
module is provided and is available on the same platforms as are indicated in the
Availability section above. The SQL Server XA switch module is also provided.

To build the SQL Server XA module, you must have the Windows Software
Development Kit (SDK) installed for your version of Windows.

Native COBOL
and .NET
Managed
COBOL

• OpenESQL supports access to relational databases using ODBC 3.0-compliant
drivers

• Refer to your driver vendor's documentation to determine whether your driver is
suitable for use with OpenESQL

JVM Managed
COBOL

OpenESQL supports access to relational databases using JDBC 4.0-compliant JDBC
drivers. To use JDBC DataSource Objects, you must also install and configure a JNDI
server.

If you are using a Java application server, it includes a JNDI server you can use to
configure DataSource Object. This process is described in the Java documentation for
the application server.

If you are not using a Java application server, or if you require a standalone JNDI server
to configure DataSource objects for initial evaluation and development, see the Simple-
JNDI topic in this documentation set for instructions on downloading, installing, and
using the open source JNDI server Simple-JNDI for this purpose.

Database Access - HCO for SQL Server (HCOSS)

Back to Top

Microsoft SQL
Server

SQL Server 2008 R2 or later, Developer or Enterprise Editions, including Microsoft SQL
Server Management Studio.

Database
Migration

• Microsoft .NET Framework 4.0
• Microsoft OLE DB Provider for DB2, available in the SQL Server 2008 R2 or later

Feature Pack

Note: Be sure to configure the OLE DB Provider to connect to the mainframe.
See your Microsoft documentation for details.

• Mainframe DB2
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Note:

• We support only the mainframe DB2 versions that are currently under IBM
support.

• If you intend to develop applications on your local machine, but deploy
applications to a SQL Server database on a remote machine, you can install
SQL Server Native Client 10.x (or later) for ODBC connectivity on your local
machine instead of installing SQL Server. For SQL Server 2014 connectivity,
you can install Microsoft ODBC Driver 11.0 for SQL Server. For information on
configuring a deployment machine, see the section Deploying Native
Applications below.

Deploying
Native
Applications

Development
Machine

• Visual COBOL for Eclipse
• If SQL Server 2008 R2 or 2012 is not installed, you must have

Microsoft SQL Server 2008 R2 or 2012 Native Client installed.
For SQL Server 2014, you must have Microsoft ODBC Driver
11.0 for SQL Server.

Development
SQL Server
Machine

SQL Server 2008 R2 or later

Note: This can be the same machine as the development
machine, but is not required to be

Deployment
Machine

• COBOL Server or COBOL Server for Unit Testing installed
• If SQL Server 2008 R2 or 2012 is not installed, you must have

Microsoft SQL Server 2008 R2 or 2012 Native Client installed.
For SQL Server 2014, you must have Microsoft ODBC Driver
11.0 for SQL Server.

If you want to bind your application from the deployment machine,
install the following software in addition:

• Microsoft .NET 3.5 framework, or later
• SQL Server 2008 R2 or later System CLR Types
• SQL Server 2008 R2 or later Shared Management Objects

Deployment
SQL Server
Machine

SQL Server 2008 R2 or later

Note: This can be the same machine as the deployment
machine, but is not required to be

Database Access - DB2 ECM

Back to Top

Availability Feature/Platform 32-bit 64-bit

x86-64 running
Windows

X X

XA Switch Module When the Enterprise Server feature is enabled, the DB2 XA switch module is
provided and is available on the same platforms as are indicated in the
Availability section above.

Certification of
RDBMS

Certification of RDBMS precompilers with Micro Focus products is the
responsibility of the RDBMS vendor, rather than Micro Focus. You can find IBM
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Precompilers for
Native COBOL

document certification information for DB2/COBOL applications within the IBM
Information Center for DB2, in the topic Support for database application
development in COBOL.

Preprocessor DB2 ECM supports the following database preprocessors:

• IBM DB2 LUW Version 9.5 or later
• IBM DB2 Connect Version 9.5 or later

XML Extensions

Back to Top

• XML Extensions has the same requirements as Visual COBOL. Both 32-bit and 64-bit versions are
available. See the XML Extensions for Visual COBOL, available from the Visual COBOL product
documentation section of the Micro Focus SupportLine Web site for more details.

• Additionally, XML Extensions may be used in conjunction with Terminal Server.

Installing Visual COBOL for Eclipse (Windows)

Downloading the Product
1. Use the download links in your Electronic Product Delivery email.

For more information follow the links for the installation instructions and the End User License
Agreement.

Product Co-Existence
• Visual COBOL and COBOL Server cannot coexist on the same machine.
• Visual COBOL and Enterprise Developer cannot coexist on the same machine regardless of which IDE

(Visual Studio or Eclipse) you install.
• Visual COBOL is available in different IDE variants, each one of which is targeted by one specific

variant of the development product:

• COBOL Server - the deployment environment for COBOL applications created with Visual COBOL
for Visual Studio 2010 or Visual COBOL for Eclipse

• COBOL Server 2012 - the deployment environment for COBOL applications created with Visual
COBOL for Visual Studio 2012

• COBOL Server 2013 - the deployment environment for COBOL applications created with Visual
COBOL for Visual Studio 2013

Installing as an Upgrade
This release will update an existing installation of Visual COBOL 2.2.

• Before installing this release as an upgrade to an existing installation of the previous version 2.2 of the
product, you must uninstall any HotFixes of 2.2. This is to avoid some problems that might result in files
not being installed.

• Before installing this release as an upgrade, ensure you create a back-up of your Enterprise Server
configuration. To do this, on the Enterprise Server Administration home page, click Export and then
select Export Enterprise Server configuration and Security Manager definitions. This creates a
backup folder in the c:\programdata\micro focus\Enterprise Developer\MFDS. You can
restore the Enterprise Server configuration after installing this release - click Import on the Enterprise
Server Administration home page.
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Installing
Note:

• Before installing, check Installation Restrictions and Requirements.
• The setup file installs Visual COBOL and Eclipse 3.8. After the installation is completed, you can

install Visual COBOL into a newer version of Eclipse such as version 4.2 or 4.3 for the 32-bit
Eclipse only - see Installing Visual COBOL into other instances of Eclipse for instructions.

• See Installing as an Upgrade first for important information when upgrading an existing installation
of Visual COBOL.

• This version of the product is a full install.

These are the steps to install this product:

1. Run the vce_222.exe file and follow the wizard instructions to complete the installation.

By default, this installs Visual COBOL in the %ProgramFiles(x86)%\Micro Focus\Visual COBOL
folder and installs a full version of Eclipse 3.8, with the Micro Focus plugins already installed, in the C:
\Users\Public\Micro Focus\Product Name\eclipse directory. On older versions of Windows,
Eclipse might be installed in a different folder, such as for Windows XP, in %ProgramFiles(x86)%
\Micro Focus\Visual COBOL\eclipse. The setup file installs any missing prerequisite software as
listed in the topic Software Requirements.

Note:

• If you are installing onto a machine that has an existing Micro Focus product that uses an older
Sentinel RMS License Manager, you might be prompted to remove it and install the Micro Focus
License Administration. By doing this you maintain the existing Sentinel RMS license files while
adding the Micro Focus License Administration. If you are unsure about existing licenses on your
computer or removing the Sentinel RMS License Manager, consult your System Administrator. If
you want to proceed, remove Sentinel RMS License Manager by using Add or Remove
Programs (Windows XP) or Program and Features (Windows Vista or later), and rerun the
installation file.

• Trial licenses cannot be used with remote desktop services. If you want to use your product in this
way, please contact Micro Focus SupportLine to obtain a relevant license.

• We recommend that you install any updates for the .NET Framework that are available at the 
Microsoft Download site.

• If you install JDK you might be prompted to install the latest update. The latest update is not
required for use with Visual COBOL but you can install it if you wish.

Installing Silently
You can install Micro Focus products silently by using command line parameters to specify the installation
directory, user information, and which features to install. You must execute the command with superuser
permissions.

To install silently use the following command:

start /wait install-file.exe /q [parameters]

where install-file for the following products is as follows:

Visual COBOL vce_222.exe

To see what parameters you can use, execute the following from the command line:

install-file /help

See the Examples section further in this topic for examples of some of the parameters you can use.

After the application installation is complete you can install the license silently by executing the following
commands:
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If you have access to the
Internet and an
authorization code

For 32-bit Windows environments:

start /wait "" "C:\Program Files\Common Files\SafeNet 
Sentinel\Sentinel RMS License Manager\WinNT
\cesadmintool" -term activate AuthorizationCode

For 64-bit Windows environments:

start /wait "" "C:\Program Files (x86)\Common Files
\SafeNet Sentinel\Sentinel RMS License Manager\WinNT
\cesadmintool" -term activate AuthorizationCode

If you don't have access to
the Internet but have a file
from Micro Focus that
contains the license string

For 32-bit Windows environments:

start /wait "" "C:\Program Files\Common Files\SafeNet 
Sentinel\Sentinel RMS License Manager\WinNT
\cesadmintool" -term install -f FileName

For 64-bit Windows environments:

start /wait "" "C:\Program Files (x86)\Common Files
\SafeNet Sentinel\Sentinel RMS License Manager\WinNT
\cesadmintool" -term install -f FileName

where FileName is the name of the text file that contains all the license
strings to be used.

Directory considerations

• You must have read and write access for every directory accessed during the installation.
• You can override the default installation folder using the INSTALLDIR parameter:
• If a path in a definition contains spaces, then the path must be preceded by a backslash and double

quotation mark (\"). For example:

INSTALLDIR=path
INSTALLDIR=\"c:\MyProduct\" 
INSTALLDIR=\"c:\Program Files\Micro Focus\My Product\"

• Installing creates a log file in %temp%\LogFilename by default. To change the location or name, use
the /log parameter on your Setup command line and specify the path and file name, for example:

The default names for the log files are as follows:

Micro_Focus_Visual_COBOL_for_IDE_date
.log

for the Visual COBOL wrapper

Micro_Focus_Visual_COBOL_for_IDE_date
.log

for Visual COBOL, where ?? is "86" for 32-bit systems
and "64" for 64-bit systems

lmsetup_install_log.txt for Micro Focus License Administration

• The log filename and folder name cannot contain spaces
• The log file folder must exist before beginning the silent install

Examples

• To silently install Visual COBOL into a directory other than the default:

start /wait vce_222.exe /q InstallFolder=c:\DirectoryName

• If you want to silently install the Eclipse IDE in a location other than the default, execute:

start /wait vce_222.exe /q InstallFolder2=c:\EclipseInstallDirectory
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Installing Visual COBOL into other instances of Eclipse
Visual COBOL ships with Eclipse 3.8 but can be installed in other instances of Eclipse available on the
same machine. The supported versions of Eclipse are 3.8, 4.2 and 4.3 only for the 32-bit Eclipse.

Note: Though Visual COBOL does not support the 64-bit Eclipse, you can use the 32-bit Eclipse to
create both 32-bit and 64-bit applications.

To assist you with automatically installing the Micro Focus plug-ins in other instances of Eclipse, Visual
COBOL provides an installation utility, installeclipseplugins.bat available in
%ProgramFiles(x86)%\Micro Focus\Visual COBOL\installer.

To use the script to install Visual COBOL into another instance of Eclipse:

1. Start a Visual COBOL command prompt.
2. At the command prompt, navigate to the location of the install utility.
3. Run the install utility from the command prompt using the following syntax:

installeclipseplugins -eclipse <EclipseInstallDir> -version <version> [-
cobdir <InstallDir>]

Where:

• EclipseInstallDir - full path to the installation directory of the instance of Eclipse you are installing
into.

• version - version number of the instance of Eclipse that you are installing into. The valid version
numbers are 3.8, 4.2 and 4.3 and these also cover for minor version numbers such as 3.8.1 or 4.2.2.

• InstallDir - optional. The full path to the installation directory of Visual COBOL. If this is not specified,
the COBDIR environment variable is used.

Running the utility installs the Visual COBOL plug-ins into the specified version of Eclipse and copies
the Visual COBOL UpdateSite folders into EclipseInstallDir\eclipse\dropins.

For example, to install Visual COBOL into an instance of Eclipse 4.3 available in the c:\eclipse
folder, run the install utility with the following parameters:

installeclipseplugins -eclipse c:\eclipse -version 4.3

After Installing
If you have used Eclipse from the same workspace before, the Eclipse perspective settings are not reset
after installing any Micro Focus product. To pick up any new features, you must reset the COBOL
perspective after installation:

1. Open the existing workspace with this product.

You may receive some warnings or errors which you can ignore.
2. Make sure you are in the COBOL perspective by clicking Window > Open Perspective > COBOL.
3. Click Window > Reset Perspective.
4. Click OK.
5. Reapply any customizations.

Note: For applications created with earlier Micro Focus products, note the following:

Existing
Applications

Application executables that were compiled using earlier Micro Focus
products must be recompiled from the sources using Visual COBOL.

Open PL/I
Compiler

Important: If you are installing this release as an upgrade to Enterprise
Developer 2.2 Update 1, after the upgrade you must rebuild any applications that
are compiled using the –zp1 option.
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The behavior of the –zp1 option has been reverted to that of versions of Enterprise
Developer earlier than 2.2 Update 1, with an additional correction relating to Char
Varying data items.

The behavior has been restored to that in Enterprise Developer versions earlier than
2.2 where, when compiling with –zp1, all parameters are treated as unaligned. (In
Enterprise Developer 2.2 Update 1, the behavior when compiling with –zp1 was to not
treat parameters as if unaligned).

When using the –zp1 compiler option, all Character Varying data items are now treated
as if unaligned. In previous versions of Open PL/I, for Character Varying data items,
the –zp1 unaligned requirement was applied only to structure members and
parameters.

To illustrate the change, consider the following example:

zptest: proc options(main); 
 
   dcl 1 st1, 
     2 c char, 
     2 x(4) char(7) var init ('a', 'xx', 'yyy', 'zzzz'); 
 
   dcl y(4) char(7) var init ('a', 'xx', 'yyy', 'zzzz'); 
 
   dcl sub entry ((4) char(7) var); 
 
   call sub (x); 
 
   call sub (y); 
 
end; 
 
sub: proc (z); 
 
   dcl z(4) char(7) var; 
 
   dcl i fixed bin(31); 
 
  do i = 1 to hbound(z); 
      z(i)  = 'x'; 
  end; 
 
end; 

Where:

• For x and z, each char (7) var item is 7 plus 2 bytes which equals 9 and then
multiplied by 4 equals 36.

• If y were aligned on half-word by default, each array element is half-word aligned
and each equals 10 bytes (9 + 1 pad byte), and the total size equals 40 bytes.

• At call sub (x), the calling argument and parameter are matched.
• At the call sub (y), the y element size (10 bytes) is mismatched against the

parameter z element size (9 bytes) due to –zp1. This is incorrect and causes
unexpected program behavior.

Due to this correction of treating all Char Varying data items as if unaligned when using
–zp1, the size of CHAR VARYING arrays now differs from previous versions of Open-
PL/I. For example:

   dcl X(4) char(7) var; 
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   Put skip list (size(X))  /* size is 36 bytes vs. 40 bytes in 
previous versions of Open-PL1 */ 

Installing X Windows on Windows
Some features of Visual COBOL for Eclipse on Windows require an X Windows installation, hence Micro
Focus ViewNowX is provided with the product. To install, run the file ViewNow_X_Server.exe in your
Visual COBOL installation. By default this will be in the %ProgramFiles(x86)%\Micro Focus\Visual
COBOL\ViewNowX folder.

ViewNowX requires that your client machine has Microsoft Visual C++ 2008 SP1 Redistributable Package
(x86) installed. If it is missing from your machine, the ViewNowX installation will offer a link to download the
package.

Repairing
If any product files, registry settings or shortcuts are accidentally removed at any point, you can perform a
repair on the installation to replace them.

To repair your installation on versions of Windows Vista or later:

1. From the Control Panel, click Uninstall a program under Programs.
2. Right-click your Micro Focus product and select Repair.

To repair your installation on older versions of Windows, such as Windows XP:

1. Click Start Menu > Control Panel > Add/Remove Programs.
2. Click your Micro Focus product in the list of installed programs.
3. Click Click here for support information.
4. Click Repair.

Uninstalling

Windows

To uninstall the product, you cannot simply delete its files from your hard disk. To uninstall the product:

1. Log in with the same user-ID as you used when you installed the product.
2. Click Uninstall a program under Programs (or Add/Remove Programs on older versions of

Windows) in Control Panel.
3. On older versions of Windows such as Windows XP, ensure that Show Updates (at the top of the Add

or Remove Programs dialog) is checked, so that any hot fixes or WrapPacks are listed.
4. Select the product and click Remove or Uninstall as appropriate.

When you uninstall, the only files deleted are those that the installation software installed. If the product
directory has not been removed, delete any unwanted files and subdirectories within it using Windows
Explorer.

Important: The installer creates separate installations for Micro Focus Visual COBOL and Micro
Focus License Administration. Uninstalling only Visual COBOL does not automatically uninstall the
Micro Focus License Administration or any of the prerequisite software.

To completely remove the product you must uninstall the Micro Focus License Administration as well.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.

To silently uninstall the product, you need the setup file and you need to execute the following at the
command line:

start /wait install-file.exe /quiet /uninstall
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Installing Visual COBOL for Eclipse (UNIX)

System Requirements for Visual COBOL for Eclipse
(UNIX)

Hardware Requirements for Visual COBOL for Eclipse
Visual COBOL has the following requirements in addition to the requirements of Eclipse. See the Eclipse
documentation for details of its requirements.

The disk space requirements are approximately:

Platform Setup

file size

(MB)

Disk space

required for

the installation

(GB)

Disk space

required for

running

the product

(MB)

Sentinel RMS

license server

(MB)

x86-64 running
Red Hat Linux

710 2.84 1.42 40

x86-64 running
SuSE SLES

714 2.87 1.43 40

Operating Systems Supported
Note: You can produce 64-bit and 32-bit applications on 64-bit operating systems.

For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.

Software Requirements

Eclipse requirements

• Visual COBOL only supports the 32-bit Eclipse IDE and requires a 32-bit Java installation.
• Though Visual COBOL does not support the 64-bit Eclipse, you can use the 32-bit Eclipse to create

both 32-bit and 64-bit applications.
• Visual COBOL ships with Eclipse 3.8. After the installation, you can install the Visual COBOL plug-in

into other instances of Eclipse available on the same machine. The supported versions are 3.8, 4.2 and
4.3 for the 32-bit Eclipse only. See Installing Visual COBOL into other instances of Eclipse for
instructions.

Other software requirements

Before installing this product, you must have the following software installed on your computer:

• The pax archiving utility is required by the setup file. Pax is distributed with most UNIX/Linux systems
but, if it is missing, you must install it separately. To verify pax is installed, run pax --help or pax --
version at the command line.

• On Red Hat 6.x and Red Hat 7, you must have the following operating system libraries installed:
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All Visual COBOL products
glibc-*.x86_64
glibc-*.i686
libgcc-*.x86_64
libgcc-*.i686
libstdc++-*.x86_64
libstdc++-*.i686

Additional libraries for Visual
COBOL for Eclipse

Library Platform

Red Hat 6.x Red Hat 7

gtk2-*.x86_64

gtk2-*.i686

gtk2-engines.*.i686 -

gtk2-engines.*.s390 -

gtk2-engines.*.x86_64

libXtst-*.x86_64

libXtst-*.i686

libcanberra-gtk2-
*.x86_64

libcanberra-gtk2-*.i686

libgnome.x86_64

libgnome.i686

PackageKit-gtk-
module-*.x86_64

PackageKit-gtk-
module-*.i686

-

PackageKit-gtk-
module-*.s390

-

PackageKit-gtk3-
module-*.i686

-

PackageKit-gtk3-
module-*.s390

-

webkitgtk.x86_64 -

webkitgtk.i686 -

webkitgtk3.x86_64 -

webkitgtk3.i686 -
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Library Platform

Red Hat 6.x Red Hat 7

xterm (any version)

Additional libraries required
to use the core_on_error
runtime variable

gdb - the gdb packages (for the GNU Project Debugger) can be
installed from the install media for your OS.

Additional libraries for Micro
Focus Visual COBOL
Development Hub

glibc-devel-*.x86_64
glibc-devel-*.i686

In addition, on IBM System z (390), you must have the following operating system libraries installed:

Additional libraries for Micro Focus Visual COBOL Development Hub
glibc-devel-*.s390
glibc-devel-*.s390x

Visit the Red Hat Web site for more information.

• Xterm, the terminal emulator for the X Window System, is part of your UNIX/Linux distribution but is not
installed by default. Use your UNIX/Linux installation media to install it.

• Oracle's Java Platform, Enterprise Edition (Java EE) 6 or Java 7 is required to run the Eclipse IDE, to
execute COBOL JVM code and for native COBOL and Java interoperability. The earliest supported
release of Java 6 is 1.6 Update 27. You can download Oracle's Java EE from Oracle's Web site and
install it anywhere on your machine.

Note: On Linux, the 32-bit version of Java is required to install and use Visual COBOL for Eclipse.
When you start the installation, if the 64-bit version of Java is already installed on your Linux
machine, you might not be able to install Visual COBOL. This is a known issue with the Oracle
Java installers for Linux which prevent you from installing both the 32-bit and the 64-bit versions of
Java on the same machine. To work around this problem:

• Download the 32-bit Java distribution in a compressed .tar format from the Oracle Web site.
• Untar the distribution into a location different from the one used for the 64-bit Java version. For

example, untar in /usr/local/java32 and not in /usr/local/java.
• Set JAVA_HOME and LD_LIBRARY_PATH to the 32-bit version of Java so that it is used to

install and run Visual COBOL.

Before you start the installation, you need to set the environment as follows:

• You need to set the JAVA_HOME environment variable. When installing the product, set this variable to
a 32-bit Java installation or the installation terminates. For example, execute the following:

JAVA_HOME=java_install_dir

where java_install_dir is the path to the JAVA installation directory such as /usr/java/javan.n
• You need to add $JAVA_HOME/bin to your system PATH variable. To do this, execute:

export PATH=$JAVA_HOME/bin:$PATH

• You need to set the LANG environment variable to pick up localized messages. The LANG settings are
English and Japanese only.

Important: This release requires version 10000.2.990 or later of the Micro Focus licensing software.
For local servers, you do not need to install it separately, as the setup file installs a new Visual
COBOL client and a new licensing server on the same machine.
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If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus Licensing System Administration tool. To check the version of the license server on UNIX,
run /var/microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool.sh.

You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com.

Additional Software Requirements on Linux and UNIX
To ensure full functionality for some Visual COBOL features, you might be required to obtain and install
additional third-party software in addition to the prerequisite software installed automatically by the Visual
COBOL setup file. The following information specifies the third-party software required for each feature.

• Application server support for JVM COBOL on page 19
• Database Access on page 19
• Database Access - COBSQL (Pro*COBOL) on page 20
• Database Access - OpenESQL on page 21
• Database Access - DB2 ECM on page 21
• Java Development Kit (JDK) on page 22
• XML Extensions on page 22

Application server support for JVM COBOL

Back to Top

Restriction: This topic applies only when the Enterprise Server feature is enabled.

The following application servers are supported using the following JDKs:

Application Servers JDK version Containers support version

Tomcat 7.0.39 1.6 / 1.7 Servlets 2.5

JBoss 6.1 1.6 / 1.7 Servlets 2.5

WebLogic 12.1.1 1.6 / 1.7 Servlets 2.5

WebLogic 12.1.1 on AIX 6.1 1.6.0 SR10 FP1 / 1.7 Release 1 Servlets 2.5

WebSphere 8.5 1.6 / 1.7 Servlets 2.5

WebSphere 8.5 on AIX 6.1 1.6.0 SR10 FP1 / 1.7 Release 1 Servlets 2.5

Note:

• On AIX and zLinux, you need to have IBM's JDK. The earliest supported release of IBM's JDK 1.6
is 1.6.0.13. You can get IBM's AIX JDK from IBM's Web site.

• On HP-UX, you need to have HP-UX JDK. The earliest supported release of HP-UX JDL 1.6 is
Java 6.0.13. You can get the HP-UX Java JDK from HP's Web site.

• On all other platforms, you need Oracle's JDK. The earliest supported release of Oracle's JDK 1.6
is 1.6.027. You can download Oracle's JDK from Oracle's Web site.

Database Access

Back to Top

Before you can use Visual COBOL to develop and deploy SQL applications that use COBSQL, DB2 ECM,
or OpenESQL, ensure any third-party software prerequisites are installed and the environment is set
properly.
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Database Access - COBSQL (Pro*COBOL)

Back to Top

Note: COBSQL (Pro*COBOL) is supported for native COBOL only.

Availability Feature/Platform 32-bit 64-bit

x86-64 running Red Hat
Linux

X X

x86-64 running SuSE
Linux

X X

IBM System p running
AIX

X X

IBM System z running
SuSE Linux

X X

Itanium running HP-UX X X

x86-64 running Solaris X X

SPARC running Solaris X X

XA Switch
Module

When the Enterprise Server feature is enabled, the Oracle XA switch module is
provided for COBSQL (Pro*COBOL), and is available on the same platforms as are
indicated in the Availability section above.

Certification of
RDBMS
Precompilers for
Native COBOL

Certification of RDBMS precompilers with Micro Focus products is the responsibility
of the RDBMS vendor, rather than Micro Focus. Certification information can be
found within the relevant Oracle documentation. If you have an Oracle MetaLink
account (http://metalink.oracle.com), document # 43208.1 provides details of all
language compilers certified by Oracle for use with their precompilers.

Preprocessors COBSQL supports the following database preprocessors:

• Sybase Open Client Embedded SQL/COBOL Version 11.1 or later
• Oracle Pro*COBOL Version 11.1 (11gR1) or later
• Informix Embedded SQL/COBOL Version 7.3 or later

Compiling On x86 and x86-64 platforms, when compiling with COBSQL for use with Oracle, do
not use the COBSQL directive option NOMAKESYN, since this directive results in
COMP host variables, and on Intel platforms these are incompatible with the native
byte order expected by Oracle.

Executing On HP-UX, to execute an application precompiled using Pro*COBOL (or COBSQL)
after you have created a callable shared object of Oracle DBMS routines, you need
set an environment variable, LD_PRELOAD, to point to the Oracle client callable
shared object, for example:

LD_PRELOAD=$ORACLE_HOME/libdir/libclntsh.so       
export LD_PRELOAD

where libdir is:

• lib32 for 32-bit environments
• lib for 64-bit environments.

A script is available that creates an executable run-time system or a callable shared
object containing Oracle support (applies to UNIX environments only). You can find
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the script in the Micro Focus Knowledge Base article titled Building and executing
Pro*COBOL applications on UNIX.

Database Access - OpenESQL

Back to Top

Availability Feature/Platform Native COBOL 32-bit Native COBOL 64-bit

x86-64 running Red Hat
Linux

X X

x86-64 running SuSE
Linux

X X

IBM System p running
AIX

X X

IBM System z running
SuSE Linux

X X

Itanium running HP-UX X X

x86-64 running Solaris X X

SPARC running Solaris X X

XA Switch
Module

When the Enterprise Server feature is enabled, the ODBC One-phase Commit switch
module is provided and is available on the same platforms as are indicated in the
Availability section above. For Windows environments, the SQL Server XA switch
module is also provided.

Native COBOL
and .NET
Managed COBOL

• OpenESQL supports access to relational databases using ODBC 3.0-compliant
drivers

• Refer to your driver vendor's documentation to determine whether your driver is
suitable for use with OpenESQL

Database Access - DB2 ECM

Back to Top

Availability Feature/Platform 32-bit 64-bit

x86-64 running Red
Hat Linux

X X

x86-64 running SuSE
Linux

X X

IBM System p running
AIX

X X

IBM System z running
SuSE Linux

X X

Itanium running HP-UX X

x86-64 running Solaris

SPARC running Solaris X
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XA Switch Module When the Enterprise Server feature is enabled, the DB2 XA switch module is
provided and is available on the same platforms as are indicated in the Availability
section above.

Certification of
RDBMS
Precompilers for
Native COBOL

Certification of RDBMS precompilers with Micro Focus products is the
responsibility of the RDBMS vendor, rather than Micro Focus. You can find IBM
document certification information for DB2/COBOL applications within the IBM
Information Center for DB2, in the topic Support for database application
development in COBOL.

Preprocessor DB2 ECM supports the following database preprocessors:

• IBM DB2 LUW Version 9.5 or later
• IBM DB2 Connect Version 9.5 or later

Java Development Kit (JDK)

Back to Top

Compiling
Java

Either the IBM or the Oracle Java Development Kit (JDK), version 1.5 or later, is required
for compiling Java. The JDK is downloadable from the Oracle and IBM Web sites. After
installing the JDK, you must put the tools.jar file for the JDK on your classpath, using
a command similar to:

 set classpath=jdk-install-directory\lib\tools.jar

After installing the JDK, you need to set up your Java environment.

XML Extensions

Back to Top

• XML Extensions has the same requirements as Visual COBOL. Both 32-bit and 64-bit versions are
available. See the XML Extensions for Visual COBOL, available from the Visual COBOL product
documentation section of the Micro Focus SupportLine Web site for more details.

• Additionally, XML Extensions may be used in conjunction with Terminal Server.

Installing Visual COBOL for Eclipse (UNIX)

Downloading the Product
1. Use the download links in your Electronic Product Delivery email.

For more information follow the links for the installation instructions and the End User License
Agreement.

Installing

Installing the software

Note: The setup file installs Visual COBOL and Eclipse 3.8. After the installation is completed, you
can install Visual COBOL into a newer version of Eclipse such as version 4.2 or 4.3 for the 32-bit
Eclipse only - see Installing Visual COBOL into other instances of Eclipse for instructions.

1. Give execute permissions to the setup file:

chmod +x setup_visualcobol_deveclipse_2.2_update2_platform

2. Run the setup file with superuser permissions:

. /setup_visualcobol_deveclipse_2.2_update2_platform
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If you don't run this as superuser, you are prompted to enter the superuser password during the install.

The COBOL environment is installed by default into /opt/microfocus/VisualCOBOL, (COBDIR). A
full version of Eclipse, with the Micro Focus plugins already installed, is present in the $COBDIR/
eclipse directory.

To install in a different location use the -installlocation="Location" parameter to specify an
alternative directory location. For example:

. /setup_visualcobol_deveclipse_2.2_update2_platform -installlocation="full 
path of new location"

Note: You can use variables or the tilde syntax for the path for –installlocation. For example,
the following examples are equivalent:

-installlocation="/home/myid/installdir"

-installlocation="~myid/installdir"

-installlocation="~/installdir"

-installlocation="$HOME/installdir"

You can see details about which additional parameters can be passed to the install script if you enter
the -help option.

Note:

• The installation of this product could affect the SafeNet Sentinel licensed components running
on your machine. During installation licensing is shutdown to allow files to be updated. To
ensure the processes running on your machine are not affected, you need to use the -
skipsafenet option, which skips the installation of SafeNet:

. /setup_visualcobol_deveclipse_2.2_update2_platform -skipsafenet

• To protect the SafeNet Sentinel installation from accidental updating you can create an empty
file named SKIP_SAFENET_INSTALL in /var/microfocuslicensing/ as follows:

touch /var/microfocuslicensing/SKIP_SAFENET_INSTALL

While the file is present, the SafeNet installer does not make changes to the installation or
shutdown the running license daemons. If licensing needs to be updated later, remove the file
and install Sentinel RMS server manually.

Setting up the environment

When you have installed the product, you need to set the environment as described below.

1. To set up your product, execute:

. /opt/microfocus/VisualCOBOL/bin/cobsetenv

2. To verify that your product is installed, execute:

cob -V

Important: These commands set the environment only for the current shell. You need to execute
them for each new shell that you start.

To avoid having to run cobsetenv for every shell, add these commands to the shell initialization files
(such as etc/profile, etc/bashrc).

Note that cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.

Starting the product

To start Eclipse:

Installation | 23



• If you are using a GUI interface, double-click the product icon (automatically installed on your desktop).

Note: The installer automatically creates a shortcut icon for the product on the desktop for the user
for which you ran the install script. If you need to create desktop icons for other users' desktops on
the same machine, or if the icon was not created on the desktop for the root user, run the following
shell script as the user you need to login as: $COBDIR/bin/createdesktopicon.sh

• If you are using a non-GUI interface, such as a terminal emulator, type the following from a command
prompt:

eclipse

Installing as an upgrade
This release works concurrently with the previous version of Visual COBOL, so you do not need to uninstall
it. There are two options for installing the latest version in this case:

• Move the existing installation to a different location and install the latest version to the default install
location specified by the COBDIR environment variable ( /opt/microfocus/VisualCOBOLEclipse,
by default).

This ensures you do not need to change your environment. To move the existing older installation to a
different location:

1. Execute the following command as root:

mv /opt/microfocus/VisualCOBOLEclipse /opt/microfocus/
VisualCOBOLEclipseversion

2. Install the latest version as described in the section Installing.
• Install the latest version in a different location and set the environment to point to it. To do this, run the

Visual COBOL installer with the –installlocation option:

1. Execute the following command:

. /InstallFile -installlocation="/opt/microfocus/VisualCOBOLEclipse"

Note: You can use variables or the tilde syntax for the path for –installlocation. For
example, the following examples are equivalent:

-installlocation="/home/myid/installdir"

-installlocation="~myid/installdir"

-installlocation="~/installdir"

-installlocation="$HOME/installdir"

2. Execute cobsetenv to set the environment and point to the new install location:

. /opt/microfocus/VisualCOBOL/bin/cobsetenv

Note that cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.

Installing Visual COBOL into other instances of Eclipse
Visual COBOL ships with Eclipse 3.8 but can be installed in other instances of Eclipse available on the
same machine. The supported versions of Eclipse are 3.8, 4.2 and 4.3 only for the 32-bit Eclipse.

Note: Though Visual COBOL does not support the 64-bit Eclipse, you can use the 32-bit Eclipse to
create both 32-bit and 64-bit applications.

To assist you with automatically installing the Micro Focus plug-ins in other instances of Eclipse, Visual
COBOL provides an installation utility, installeclipseplugins (UNIX) available in /opt/
microfocus/VisualCOBOL/eclipse.

To use the script to install Visual COBOL into another instance of Eclipse:
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1. Start a terminal.
2. At the terminal, navigate to the location of the install utility.
3. Run the install utility from the command prompt using the following syntax:

installeclipseplugins -eclipse <EclipseInstallDir> -version <version> [-
cobdir <InstallDir>]

Where:

• EclipseInstallDir - full path to the installation directory of the instance of Eclipse you are installing
into.

• version - version number of the instance of Eclipse that you are installing into. The valid version
numbers are 3.8, 4.2 and 4.3 and these also cover for minor version numbers such as 3.8.1 or 4.2.2.

• InstallDir - optional. The full path to the installation directory of Visual COBOL. If this is not specified,
the COBDIR environment variable is used.

Running the utility installs the Visual COBOL plug-ins into the specified version of Eclipse and copies
the Visual COBOL UpdateSite folders into EclipseInstallDir/eclipse/dropins.

UNIX and Linux Installer Issues
Installing on
Linux

On Linux, the 32-bit version of Java is required to install and use Visual COBOL for
Eclipse. When you start the installation, if the 64-bit version of Java is already installed
on your Linux machine, you might not be able to install Visual COBOL. This is a known
issue with the Oracle Java installers for Linux which prevent you from installing both the
32-bit and the 64-bit versions of Java on the same machine. To work around this
problem:

• Download the 32-bit Java distribution in a compressed .tar format from the Oracle
Web site.

• Untar the distribution into a location different from the one used for the 64-bit Java
version. For example, untar in /usr/local/java32 and not in /usr/local/
java.

• Set JAVA_HOME and LD_LIBRARY_PATH to the 32-bit version of Java so that it is
used to install and run Visual COBOL.

License
Infrastructure
Installer

• On some Solaris platforms, you can receive the following error message when
SafeNet license server needs to be installed or upgraded on your machine:

tar: /safenet.tar: No such file or directory

To resolve this issue, wait for the installation to complete and then perform the
following:

1. Navigate to the safenet directory in the COBDIR location.
2. With superuser permissions execute: ./MFLicenseServerInstall.sh

• Note: The following information applies when you are installing on Red Hat
Enterprise Linux (RHEL) 7. (RHEL 7 is a beta version and support for it is a
technical preview only).

Certain configuration changes in RHEL 7 (such as the /etc/inittab file no longer
available) required a change in the MF SafeNet license installer for this platform and
the way you can manually manage the licensing service.

By default, the MF SafeNet licensing service is still configured so that it starts
automatically when starting your machine. Only on RHEL 7, you must use the
systemctl command available with the OS if you need to override the default
behaviour – for example, if you do not want run the MF SafeNet licensing service at
start-up or if you do not want the service to automatically start when you are
configuring trace levels.
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1. Create a file, MFSafeNet.service, in /usr/lib/systemd/system/ with the
following contents:

----------- start of /usr/lib/systemd/system/
MFSafeNet.service -----------
    [Unit]
    Description=Micro Focus SafeNet licensing daemons. 
    Documentation=http://supportline.microfocus.com

    [Service]
    Type=forking
    ExecStart=/var/microfocuslicensing/bin/startboth.sh
    ExecStop=/var/microfocuslicensing/bin/stopboth.sh
    Restart=no

    [Install]
    WantedBy=multi-user.target
-----------  end of /usr/lib/systemd/system/
MFSafeNet.service  -----------

2. Use the systemctl command to manage the SafeNet service:

[ asroot ] systemctl option MFSafeNet

Where some of the values that option can take are:

reenable Installs the SafeNet service.

is-enabled Checks the status of the SafeNet service. Does not require root
privileges.

start Starts the SafeNet service.

stop Stops the SafeNet service.

restart Restarts the SafeNet service.

disable Disables the SafeNet service so it does not start when the
machine is booted.

enable Enables the SafeNet Service so it starts when the machine is
booted.

For more information about systemctl, refer to the help available with the RHEL
OS.

License
Server

You need to configure the computer hostname to ensure the license server will start
properly.

To avoid performance issues, "localhost" and the computer hostname must not both be
mapped to IP address 127.0.0.1. You should only map "localhost" to IP address
127.0.0.1.

The following is an example of how to specify these entries correctly in the etc/hosts
file:

127.0.0.1 localhost.localdomain localhost
IP machinelonghostname machineshorthostname

where IP is the unique IP address of the computer in xx.xx.xx.xx format.

Installing silently
You can install Micro Focus products silently by using command line parameters to specify the installation
directory, user information, and which features to install. You must execute the command with superuser
permissions.
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You can use the following command line arguments to install silently on UNIX/Linux:

–silent -IacceptEULA

For example, execute:

[as root] setup_filename –silent -IacceptEULA

After the application installation is complete you can install the license silently by executing the following
commands:

If you have access to the Internet
and an authorization code

Run the following as root:

cd /var/microfocuslicensing/bin
./cesadmintool.sh -authorize AuthorizationCode

If you don't have access to the
Internet but have a file from Micro
Focus that contains the license
string

Run the following as root:

cd /var/microfocuslicensing/bin
./cesadmintool.sh -install FileName

where FileName is the name of the text file that contains all the
license strings to be used.

After Installing
If you have used Eclipse from the same workspace before, the Eclipse perspective settings are not reset
after installing any Micro Focus product. To pick up any new features, you must reset the COBOL
perspective after installation:

1. Open the existing workspace with this product.

You may receive some warnings or errors which you can ignore.
2. Make sure you are in the COBOL perspective by clicking Window > Open Perspective > COBOL.
3. Click Window > Reset Perspective.
4. Click OK.
5. Reapply any customizations.

Configuring the Environment for Developing RDBMS Applications on
UNIX

Note:

• If you are working with remote projects, you need to configure the environment before you start the
remote server process.

• On UNIX, if you are working with local projects, you need to configure the environment before you
start Eclipse.

1. Ensure the COBOL and the third-party software environments are set.
2. Set up the RDBMS environment.

Refer to your RDBMS vendor documentation for details.
3. Set COBCPY as required in order for the IDE to locate any copybooks that are external to your project.
4. If working with Pro*COBOL/Cobsql applications you need to set COBOPT. This sets the appropriate

linker options for the platform and the COBOL working mode:

To do this, execute the following at the command line:

$COBDIR/src/oracle/set_cobopt_oracle
COBOPT=$PWD/cobopt.ora
export COBOPT
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Repairing
If a file in the installation of the product becomes corrupt, or is missing, we recommend that you reinstall
the product.

Uninstalling
Note: Before you uninstall the product, ensure that the Enterprise Server instances and the Micro
Focus Directory Service (MFDS) are stopped.

To uninstall this product:

1. Execute as root the Uninstall_VisualCOBOLEclipse2.2.sh script in the $COBDIR/bin directory.

Note: The installer creates separate installations for the product and for Micro Focus License
Administration. Uninstalling the product does not automatically uninstall the Micro Focus License
Administration or the prerequisite software. To completely remove the product you must uninstall the
Micro Focus License Administration as well.

To uninstall Micro Focus License Administration:

1. Execute as root the UnInstallMFLicenseServer.sh script in the /var/
microfocuslicensing/bin directory.

The script does not remove some of the files as they contain certain system settings or licenses.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.

System Requirements for Visual COBOL Development
Hub

Hardware Requirements for Micro Focus Visual
COBOL Development Hub
The disk space requirements are approximately:

Platform Setup

file size

(MB)

Disk space

required for

the installation

(GB)

Disk space

required for

running

the product

(MB)

Sentinel RMS

license server

(MB)

POWER running
AIX

361 1.44 722 33

HP IA 695 2.7 1390 61

System Z running
Red Hat Linux

315 1.26 630 34

x86-64 running
Red Hat Linux

324 1.3 648 40

SPARC running
Solaris

370 1.48 740 38

28 | Installation



Platform Setup

file size

(MB)

Disk space

required for

the installation

(GB)

Disk space

required for

running

the product

(MB)

Sentinel RMS

license server

(MB)

x86-64 running
Solaris

346 1.38 692 30

System Z running
SuSE SLES

319 1.28 638 34

x86-64 running
SuSE SLES

328 1.31 656 40

Operating Systems Supported
For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.

Software Requirements
Before installing this product, you must have the following software installed on your computer:

• The pax archiving utility is required by the setup file. Pax is distributed with most UNIX/Linux systems
but, if it is missing, you must install it separately. To verify pax is installed, run pax --help or pax --
version at the command line.

• On Red Hat 6.x and Red Hat 7, you must have the following operating system libraries installed:

All Visual COBOL products
glibc-*.x86_64
glibc-*.i686
libgcc-*.x86_64
libgcc-*.i686
libstdc++-*.x86_64
libstdc++-*.i686

Additional libraries for Visual
COBOL for Eclipse

Library Platform

Red Hat 6.x Red Hat 7

gtk2-*.x86_64

gtk2-*.i686

gtk2-engines.*.i686 -

gtk2-engines.*.s390 -

gtk2-engines.*.x86_64

libXtst-*.x86_64

libXtst-*.i686
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Library Platform

Red Hat 6.x Red Hat 7

libcanberra-gtk2-
*.x86_64

libcanberra-gtk2-*.i686

libgnome.x86_64

libgnome.i686

PackageKit-gtk-
module-*.x86_64

PackageKit-gtk-
module-*.i686

-

PackageKit-gtk-
module-*.s390

-

PackageKit-gtk3-
module-*.i686

-

PackageKit-gtk3-
module-*.s390

-

webkitgtk.x86_64 -

webkitgtk.i686 -

webkitgtk3.x86_64 -

webkitgtk3.i686 -

xterm (any version)

Additional libraries required
to use the core_on_error
runtime variable

gdb - the gdb packages (for the GNU Project Debugger) can be
installed from the install media for your OS.

Additional libraries for Micro
Focus Visual COBOL
Development Hub

glibc-devel-*.x86_64
glibc-devel-*.i686

In addition, on IBM System z (390), you must have the following operating system libraries installed:

Additional libraries for Micro Focus Visual COBOL Development Hub
glibc-devel-*.s390
glibc-devel-*.s390x

Visit the Red Hat Web site for more information.

• Xterm, the terminal emulator for the X Window System, is part of your UNIX/Linux distribution but is not
installed by default. Use your UNIX/Linux installation media to install it.

• Oracle's Java Platform, Enterprise Edition (Java EE) 6 or Java 7 is required to execute COBOL JVM
code and for native COBOL and Java interoperability. The earliest supported release of Java 6 is 1.6
Update 27. You can download Oracle's Java EE from Oracle's web site and install it anywhere on your
machine.
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Note:

• On AIX and zLinux, you need to have IBM's JDK. The earliest supported release of IBM's JDK
1.6 is 1.6.0.13. You can get IBM's AIX JDK from IBM's Web site.

• On HP-UX, you need to have HP-UX JDK. The earliest supported release of HP-UX JDL 1.6 is
Java 6.0.13. You can get the HP-UX Java JDK from HP's Web site.

Before you start the installation, you need to set the environment as follows:

• You need to set the JAVA_HOME environment variable. When installing the product, set this variable to
a 32-bit Java installation or the installation terminates. For example, execute the following:

JAVA_HOME=java_install_dir

where java_install_dir is the path to the JAVA installation directory such as /usr/java/javan.n
• You need to add $JAVA_HOME/bin to your system PATH variable. To do this, execute:

export PATH=$JAVA_HOME/bin:$PATH

• You need to set the LANG environment variable to pick up localized messages. The LANG settings are
English and Japanese only.

Important: This release requires version 10000.2.990 or later of the Micro Focus licensing software.
For local servers, you do not need to install it separately, as the setup file installs a new Visual
COBOL client and a new licensing server on the same machine.

If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus Licensing System Administration tool. To check the version of the license server on UNIX,
run /var/microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool.sh.

You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com.

Additional Software Requirements for Micro Focus
Visual COBOL Development Hub
To ensure full functionality for some Visual COBOL features, you might be required to obtain and install
additional third-party software in addition to the prerequisite software installed automatically by the Visual
COBOL setup file. The following information specifies the third-party software required for each feature.

• Application server support for JVM COBOL on page 31
• Java Development Kit (JDK) on page 32
• Database Access on page 32
• Database Access - COBSQL (Pro*COBOL) on page 32
• Database Access - OpenESQL on page 33
• Database Access - DB2 ECM on page 34
• XML Extensions on page 35

Application server support for JVM COBOL

Back to Top

Restriction: This topic applies only when the Enterprise Server feature is enabled.

The following application servers are supported using the following JDKs:
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Application Servers JDK version Containers support version

Tomcat 7.0.39 1.6 / 1.7 Servlets 2.5

JBoss 7.1.1 1.6 / 1.7 Servlets 2.5

WebLogic 12.1.1 1.6 / 1.7 Servlets 2.5

WebLogic 12.1.1 on AIX 6.1 1.6.0 SR10 FP1 / 1.7 Release 1 Servlets 2.5

WebSphere 8.5 1.6 / 1.7 Servlets 2.5

WebSphere 8.5 on AIX 6.1 1.6.0 SR10 FP1 / 1.7 Release 1 Servlets 2.5

Note:

• On AIX and zLinux, you need to have IBM's JDK. The earliest supported release of IBM's JDK 1.6
is 1.6.0.13. You can get IBM's AIX JDK from IBM's Web site.

• On HP-UX, you need to have HP-UX JDK. The earliest supported release of HP-UX JDL 1.6 is
Java 6.0.13. You can get the HP-UX Java JDK from HP's Web site.

• On all other platforms, you need Oracle's JDK. The earliest supported release of Oracle's JDK 1.6
is 1.6.027. You can download Oracle's JDK from Oracle's Web site.

Java Development Kit (JDK)

Back to Top

Compiling Java Either the IBM or the Oracle Java Development Kit (JDK), version 1.5 or later, is
required for compiling Java.

Interface
Mapping Toolkit
(IMTK)

Restriction: This feature applies only when the Enterprise Server feature is
enabled.

The JDK is required for generating Java interfaces from the Interface Mapping Toolkit
or the imtkmake command.

Java Beans Your Java client needs to be compiled with JDK 1.6 or greater.

EJBs Use the same JDK vendor and version that is used by the application
server.

After installing the JDK, you need to set up your Java environment.

Database Access

Back to Top

Before you can use Visual COBOL to develop and deploy SQL applications that use COBSQL, DB2 ECM,
or OpenESQL, ensure any third-party software prerequisites are installed and the environment is set
properly.

Database Access - COBSQL (Pro*COBOL)

Back to Top

Note: COBSQL (Pro*COBOL) is supported for native COBOL only.

Availability Feature/Platform 32-bit 64-bit

x86-64 running Red Hat
Linux

X X
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Feature/Platform 32-bit 64-bit

x86-64 running SuSE
Linux

X X

IBM System p running
AIX

X X

IBM System z running
SuSE Linux

X X

Itanium running HP-UX X X

x86-64 running Solaris X X

SPARC running Solaris X X

XA Switch
Module

When the Enterprise Server feature is enabled, the Oracle XA switch module is
provided for COBSQL (Pro*COBOL), and is available on the same platforms as are
indicated in the Availability section above.

Certification of
RDBMS
Precompilers for
Native COBOL

Certification of RDBMS precompilers with Micro Focus products is the responsibility
of the RDBMS vendor, rather than Micro Focus. Certification information can be
found within the relevant Oracle documentation. If you have an Oracle MetaLink
account (http://metalink.oracle.com), document # 43208.1 provides details of all
language compilers certified by Oracle for use with their precompilers.

Preprocessors COBSQL supports the following database preprocessors:

• Sybase Open Client Embedded SQL/COBOL Version 11.1 or later
• Oracle Pro*COBOL Version 11.1 (11gR1) or later
• Informix Embedded SQL/COBOL Version 7.3 or later

Compiling On x86 and x86-64 platforms, when compiling with COBSQL for use with Oracle, do
not use the COBSQL directive option NOMAKESYN, since this directive results in
COMP host variables, and on Intel platforms these are incompatible with the native
byte order expected by Oracle.

Executing On HP-UX, to execute an application precompiled using Pro*COBOL (or COBSQL)
after you have created a callable shared object of Oracle DBMS routines, you need
set an environment variable, LD_PRELOAD, to point to the Oracle client callable
shared object, for example:

LD_PRELOAD=$ORACLE_HOME/libdir/libclntsh.so       
export LD_PRELOAD

where libdir is:

• lib32 for 32-bit environments
• lib for 64-bit environments.

A script is available that creates an executable run-time system or a callable shared
object containing Oracle support (applies to UNIX environments only). You can find
the script in the Micro Focus Knowledge Base article titled Building and executing
Pro*COBOL applications on UNIX.

Database Access - OpenESQL

Back to Top
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Availability Feature/Platform Native COBOL 32-bit Native COBOL 64-bit

x86-64 running Red Hat
Linux

X X

x86-64 running SuSE
Linux

X X

IBM System p running
AIX

X X

IBM System z running
SuSE Linux

X X

Itanium running HP-UX X X

x86-64 running Solaris X X

SPARC running Solaris X X

XA Switch
Module

When the Enterprise Server feature is enabled, the ODBC One-phase Commit switch
module is provided and is available on the same platforms as are indicated in the
Availability section above.

Native COBOL • OpenESQL supports access to relational databases using ODBC 3.0-compliant
drivers

• Refer to your driver vendor's documentation to determine whether your driver is
suitable for use with OpenESQL

JVM Managed
COBOL

OpenESQL supports access to relational databases using JDBC 4.0-compliant JDBC
drivers. In order to utilize JDBC DataSource Objects, you must also install and
configure a JNDI server.

Database Access - DB2 ECM

Back to Top

Availability Feature/Platform 32-bit 64-bit

x86-64 running Red Hat
Linux

X X

x86-64 running SuSE
Linux

X X

IBM System p running
AIX

X X

IBM System z running
SuSE Linux

X X

Itanium running HP-UX X

x86-64 running Solaris

SPARC running Solaris X

XA Switch Module When the Enterprise Server feature is enabled, the DB2 XA switch module is
provided and is available on the same platforms as are indicated in the Availability
section above.
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Certification of
RDBMS
Precompilers for
Native COBOL

Certification of RDBMS precompilers with Micro Focus products is the responsibility
of the RDBMS vendor, rather than Micro Focus. You can find IBM document
certification information for DB2/COBOL applications within the IBM Information
Center for DB2, in the topic Support for database application development in
COBOL.

Preprocessor DB2 ECM supports the following database preprocessors:

• IBM DB2 LUW Version 9.5 or later
• IBM DB2 Connect Version 9.5 or later
• On SPARC running Solaris, 64-bit is supported in IBM versions 10.1 or later

XML Extensions

Back to Top

• XML Extensions has the same requirements as Visual COBOL. Both 32-bit and 64-bit versions are
available. See the XML Extensions for Visual COBOL, available from the Visual COBOL product
documentation section of the Micro Focus SupportLine Web site for more details.

• Additionally, XML Extensions may be used in conjunction with Terminal Server.

Installing Visual COBOL Development Hub

Downloading the Product
1. Use the download links in your Electronic Product Delivery email.

For more information follow the links for the installation instructions and the End User License
Agreement.

Installing
Note:

During the installation process, the installer configures the product's Enterprise Server System
Administrator Process User ID. The Process User ID will be the owner of all Enterprise Server
processes except the one for the Micro Focus Directory Server (MFDS). The Directory Server process
(Enterprise Server Administration) runs as root as this allows it to access the system files and ports.

All Enterprise Server processes you start from Enterprise Server Administration run under the
Process User ID which can affects the file access and creation.

By default, the installer uses the login id of the user that runs the installer for the Process User ID. To
change the user id after you complete the installation, execute $COBDIR/bin/casperm.sh.

These are the steps to install this product:

1. Give execute permissions to the setup file:

chmod +x setup_visualcobol_devhub_2.2_update2_platform

2. Run the installer with superuser permissions:

./setup_visualcobol_devhub_2.2_update2_platform

If you don't run this as superuser you will be prompted to enter the superuser password during the
installation.

The COBOL environment is installed by default into /opt/microfocus/VisualCOBOL, (COBDIR).
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To install in a different location use the -installlocation="Location" parameter to specify an
alternative directory location. For example:

./setup_visualcobol_devhub_2.2_update2_platform -installlocation="full path 
of new location"

Note: You can use variables or the tilde syntax for the path for –installlocation. For example,
the following examples are equivalent:

-installlocation="/home/myid/installdir"

-installlocation="~myid/installdir"

-installlocation="~/installdir"

-installlocation="$HOME/installdir"

You can see details about which additional parameters can be passed to the install script if you enter
the -help option.

You can use the following options to configure the Enterprise Server installation: [ -
ESsysLog="location" ] [ -ESadminID="User ID" ] [ -CASrtDir="location" ],
where:

-ESsysLog Specifies a location in which the build will create the Enterprise Server System log file -
for example, -ESsysLog="/home/esuser/logs". The default location is /var/
mfcobol/logs.

-ESadminID Sets the Enterprise Server System Administrator Process User ID from the command
line - for example, -EDadminID="esadm". The default user ID is the one that runs the
installer.

-CASrtDir Specifies the location were the Enterprise Server run-time system files are placed - for
example, -CASrtDir="/home/esuser/casrt/es". The default location is /var/
mfcobol/es.

Note:

• The installation of this product could affect the SafeNet Sentinel licensed components running
on your machine. During installation licensing is shutdown to allow files to be updated. To
ensure the processes running on your machine are not affected, you need to use the -
skipsafenet option, which skips the installation of SafeNet:

./setup_visualcobol_devhub_2.2_update2_platform -skipsafenet

• To protect the SafeNet Sentinel installation from accidental updating you can create an empty
file named SKIP_SAFENET_INSTALL in /var/microfocuslicensing/ as follows:

touch /var/microfocuslicensing/SKIP_SAFENET_INSTALL

While the file is present, the SafeNet installer does not make changes to the installation or
shutdown the running license daemons. If licensing needs to be updated later, remove the file
and install Sentinel RMS server manually.

1. To set up your product, execute:

. /opt/microfocus/VisualCOBOL/bin/cobsetenv

2. To verify that your product is installed, execute:

cob -V

Important: These commands set the environment only for the current shell. You need to execute
them for each new shell that you start.

To avoid having to run cobsetenv for every shell, add these commands to the shell initialization files
(such as etc/profile, etc/bashrc).
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Note that cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.

Note: For information about the Micro Focus Visual COBOL Development Hub, check the help for
Visual COBOL for Eclipse that is available online on the Micro Focus Infocenter.

Installing as an Upgrade
This release works concurrently with the previous version of Micro Focus Visual COBOL Development
Hub, so you do not need to uninstall it. There are two options for installing the latest version in this case:

• Move the existing installation to a different location and install the latest version to the default install
location specified by the COBDIR environment variable (/opt/microfocus/VisualCOBOL, by
default).

This ensures you do not need to change your environment. To move the existing older installation to a
different location:

1. Execute the following command as root:

mv /opt/microfocus/VisualCOBOL /opt/microfocus/VisualCOBOLversion

2. Install the latest version as described in the section Installing.
• Install the latest version in a different location and set the environment to point to it. To do this, run the

Micro Focus Visual COBOL Development Hub installer with the –installlocation option:

1. Execute the following command:

. /InstallFile -installlocation="/opt/microfocus/VisualCOBOL"

Note: You can use variables or the tilde syntax for the path for –installlocation. For
example, the following examples are equivalent:

-installlocation="/home/myid/installdir"

-installlocation="~myid/installdir"

-installlocation="~/installdir"

-installlocation="$HOME/installdir"

2. Execute cobsetenv to set the environment and point to the new install location:

. /opt/microfocus/VisualCOBOL/cobsetenv

Note that cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.

Installing silently
You can install Micro Focus products silently by using command line parameters to specify the installation
directory, user information, and which features to install. You must execute the command with superuser
permissions.

You can use the following command line arguments to install silently on UNIX/Linux:

–silent -IacceptEULA

For example, execute:

[as root] setup_filename –silent -IacceptEULA

After the application installation is complete you can install the license silently by executing the following
commands:
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If you have access to the Internet
and an authorization code

Run the following as root:

cd /var/microfocuslicensing/bin
./cesadmintool.sh -authorize AuthorizationCode

If you don't have access to the
Internet but have a file from Micro
Focus that contains the license
string

Run the following as root:

cd /var/microfocuslicensing/bin
./cesadmintool.sh -install FileName

where FileName is the name of the text file that contains all the
license strings to be used.

UNIX and Linux Installer Issues
Installing on
Linux

On Linux, the 32-bit version of Java is required to install and use Visual COBOL for
Eclipse. When you start the installation, if the 64-bit version of Java is already installed
on your Linux machine, you might not be able to install Visual COBOL. This is a known
issue with the Oracle Java installers for Linux which prevent you from installing both the
32-bit and the 64-bit versions of Java on the same machine. To work around this
problem:

• Download the 32-bit Java distribution in a compressed .tar format from the Oracle
Web site.

• Untar the distribution into a location different from the one used for the 64-bit Java
version. For example, untar in /usr/local/java32 and not in /usr/local/
java.

• Set JAVA_HOME and LD_LIBRARY_PATH to the 32-bit version of Java so that it is
used to install and run Visual COBOL.

License
Infrastructure
Installer

• On some Solaris platforms, you can receive the following error message when
SafeNet license server needs to be installed or upgraded on your machine:

tar: /safenet.tar: No such file or directory

To resolve this issue, wait for the installation to complete and then perform the
following:

1. Navigate to the safenet directory in the COBDIR location.
2. With superuser permissions execute: ./MFLicenseServerInstall.sh

• Note: The following information applies when you are installing on Red Hat
Enterprise Linux (RHEL) 7. (RHEL 7 is a beta version and support for it is a
technical preview only).

Certain configuration changes in RHEL 7 (such as the /etc/inittab file no longer
available) required a change in the MF SafeNet license installer for this platform and
the way you can manually manage the licensing service.

By default, the MF SafeNet licensing service is still configured so that it starts
automatically when starting your machine. Only on RHEL 7, you must use the
systemctl command available with the OS if you need to override the default
behaviour – for example, if you do not want run the MF SafeNet licensing service at
start-up or if you do not want the service to automatically start when you are
configuring trace levels.

1. Create a file, MFSafeNet.service, in /usr/lib/systemd/system/ with the
following contents:

----------- start of /usr/lib/systemd/system/
MFSafeNet.service -----------
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    [Unit]
    Description=Micro Focus SafeNet licensing daemons. 
    Documentation=http://supportline.microfocus.com

    [Service]
    Type=forking
    ExecStart=/var/microfocuslicensing/bin/startboth.sh
    ExecStop=/var/microfocuslicensing/bin/stopboth.sh
    Restart=no

    [Install]
    WantedBy=multi-user.target
-----------  end of /usr/lib/systemd/system/
MFSafeNet.service  -----------

2. Use the systemctl command to manage the SafeNet service:

[ asroot ] systemctl option MFSafeNet

Where some of the values that option can take are:

reenable Installs the SafeNet service.

is-enabled Checks the status of the SafeNet service. Does not require root
privileges.

start Starts the SafeNet service.

stop Stops the SafeNet service.

restart Restarts the SafeNet service.

disable Disables the SafeNet service so it does not start when the
machine is booted.

enable Enables the SafeNet Service so it starts when the machine is
booted.

For more information about systemctl, refer to the help available with the RHEL
OS.

License
Server

You need to configure the computer hostname to ensure the license server will start
properly.

To avoid performance issues, "localhost" and the computer hostname must not both be
mapped to IP address 127.0.0.1. You should only map "localhost" to IP address
127.0.0.1.

The following is an example of how to specify these entries correctly in the etc/hosts
file:

127.0.0.1 localhost.localdomain localhost
IP machinelonghostname machineshorthostname

where IP is the unique IP address of the computer in xx.xx.xx.xx format.

Configuring the Remote System Explorer Support
The remote development support from the Eclipse IDE relies upon Visual COBOL Development Hub
running on the UNIX machine and handling all requests from the IDE for building and debugging programs.
Visual COBOL Development Hub provides a UNIX daemon, the Remote Development Option (RDO)
daemon, which initiates the RDO as Eclipse clients connect to it. Whichever environment is used to start
the RDO daemon will be inherited for all servers and hence all build and debug sessions.
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Configuring the Environment

You may need to configure some aspects of the environment before you start the daemon. This is because
when a build or debug session is initiated on the Development Hub from one of the Eclipse clients, the
environment used will be inherited from whatever was used to start the daemon. A typical example of the
kind of environment that might need to be set up would include database locations and settings for SQL
access at build/run time.

Starting the Daemon

Important: Before starting the daemon you must have the following on your UNIX machine:

• a version of Perl
• a version of Java
• the as (assembler) and ld (linking) programs on the path, as specified by the PATH environment

variable

To start the daemon on the default port (4075) as a background process, perform this command with
superuser authority:

$COBDIR/remotedev/startrdodaemon

The daemon will now listen for any Eclipse client processes connecting to that machine on port 4075. If
you want to use another port, specify another port number on the startrdodaemon command.

The daemon can also be configured to instantiate the servers on a specified port or range of ports. This is
particularly relevant when you want to only open certain ports through a firewall. To do this, perform this
command with superuser authority:

$COBDIR/remotedev/startrdodaemon [<port> | <low port>-<high port>] 

where:

• <port> is the port number the daemon should use to listen for connections from Eclipse on the client
machine. If no value is given, it will be assigned a default value of 4075. This value matches the value
assigned within the Eclipse installation.

For example,

$COBDIR/remotedev/startrdodaemon 4999

This command will start a daemon listening on port 4999 and will use random server ports.
• <low port>-<high port> is the range of ports on which the servers (launched by the daemon) should use

to communicate with Eclipse on the client machine.

For example,

$COBDIR/remotedev/startrdodaemon 4080 4090-4999

This command will start a daemon listening on port 4080 and server ports will be in the range 4090 to
4999.

Stopping the Daemon

To stop the daemon, type the following command with superuser authority:

$COBDIR/remotedev/stoprdodaemon <port>

Repairing on UNIX
If a file in the installation of the product becomes corrupt, or is missing, we recommend that you reinstall
the product.
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Uninstalling
Note: Before you uninstall the product, ensure that the Enterprise Server instances and the Micro
Focus Directory Service (MFDS) are stopped.

To uninstall this product:

1. Execute as root the Uninstall_VisualCOBOLDevelopmentHub2.2.sh script in the $COBDIR/bin
directory.

Note: The installer creates separate installations for the product and for Micro Focus License
Administration. Uninstalling the product does not automatically uninstall the Micro Focus License
Administration or the prerequisite software. To completely remove the product you must uninstall the
Micro Focus License Administration as well.

To uninstall Micro Focus License Administration:

1. Execute as root the UnInstallMFLicenseServer.sh script in the /var/
microfocuslicensing/bin directory.

The script does not remove some of the files as they contain certain system settings or licenses.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.
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Licensing Information
Note:

• If you have purchased licenses for a previous release of this product, those licenses will also
enable you to use this release.

• The latest version of the SafeNet licensing software is required. See the Software Requirements
section in this document for more details.

• Your entitlement for using this product is governed by the Micro Focus End User License
Agreement and by your product order. If you are unsure of what your license entitlement is or if you
wish to purchase additional licenses, contact your sales representative or Micro Focus
SupportLine.

To buy and activate a full unlimited license
To buy a license for Visual COBOL, contact your sales representative or Micro Focus SupportLine.

For instructions on using the Micro Focus Licensing Administration Tool, see Licensing in the Visual
COBOL help.

To start Micro Focus License Administration

Windows

From the Windows Taskbar click Start > All Programs >Micro Focus License Manager > License
Administration.

Note: On Windows 8 and Windows Server 2012, you use the Start screen to invoke programs.

UNIX

Log on as root, and from a command prompt type:

/var/microfocuslicensing/bin/cesadmintool.sh

Installing licenses

If you have a license file

Windows

1. Start Micro Focus License Administration.
2. Click the Install tab.
3. Do one of the following:

• Click Browse next to the License file field and select the license file (which has an extension
of .mflic).

• Drag and drop the license file from Windows Explorer to the License file field.
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• Open the license file in a text editor, such as Notepad, then copy and paste the contents of the file
into the box below the License file field.

4. Click Install Licenses.

Alternatively, you can install the license file from within the IDE as follows:

1. Start Visual COBOL.
2. Click Help > Micro Focus > Product Licensing to open the Product Licensing dialog box.
3. Ensure I have a full Visual COBOL license is checked.
4. Click Browse next to the License file field.
5. Select the license file (which has an extension of .mflic), and then click Open.
6. Click Finish to install the license.

UNIX

1. Start the Micro Focus License Administration tool and select the Manual License Installation option by
entering 4.

2. Enter the name and location of the license file.

If you have an authorization code

Authorizing your product when you have an Internet connection
Note: This topic only applies if you have an authorization code.

The following procedure describes how to authorize your product using a local or network license server.
The license server is set up automatically when you first install the product.

Windows

1. Start Micro Focus License Administration.
2. Click the Install tab.
3. Type the authorization code in the Enter authorization code field.
4. Click Authorize.

If you change the name of the machine running your license server after it has granted licenses, the
licenses stop working.

UNIX

1. Start Micro Focus License Administration.
2. Select the Online Authorization option by entering 1 and pressing Enter.
3. Enter your authorization code at the Authorization Code prompt and then press Enter

Authorizing your product when you don't have an Internet connection
Note: This topic only applies if you have an authorization code.

This method of authorization is required if your machine does not have an Internet connection or if normal
(automatic) authorization fails.

Windows

1. Start Micro Focus License Administration.
2. Click Manual Authorization on the Install page.
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3. Make a note of the contents of the Machine ID field. You will need this later.
4. Do one of the following:

• If your machine has an Internet connection, click the SupportLine Web link in the Manual
Authorization Information window.

• If your machine does not have an Internet connection, make a note of the Web address and type it
into a Web browser on a machine that has an Internet connection.

The Micro Focus SupportLine Manual product authorization Web page is displayed.
5. Type the authorization code in the Authorization Code field. The authorization code is a 16-character

alphanumeric string supplied when you purchased your product.
6. Type the Machine ID in the Machine ID field.
7. Type your email address in the Email Address field.
8. Click Generate.
9. Copy the generated license string (or copy it from the email) and paste it into the box under the License

file field on the Install page.
10.Click Install Licenses.

UNIX

In order to authorize your product you must have the following:

• Your authorization code (a 16-character alphanumeric string).
• The machine ID. To get this, start the Micro Focus License Administration tool and select the Get

Machine Id option by inputting 6. Make a note of the "Old machine ID".

If you have previously received the licenses and put them in a text file, skip to step 6.

1. Open the Micro Focus license activation web page http://supportline.microfocus.com/activation in a
browser.

2. Enter your authorization code and old machine ID and, optionally, your email address in the Email
Address field.

3. Click Generate.
4. Copy the licenses strings from the web page or the email you receive into a file.
5. Put the license file onto your target machine.
6. Start the Micro Focus License Administration tool and select the Manual License Installation option by

inputting 4.
7. Enter the name and location of the license file.

To obtain more licenses
If you are unsure of what your license entitlement is or if you wish to purchase additional licenses for Visual
COBOL, contact your sales representative or Micro Focus SupportLine.
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New Features in Visual COBOL 2.2 Update
2

Enhancements in the Eclipse IDE
Visual COBOL provides the following new functionality and improvements:

• Support for Eclipse 4.2 and 4.3 - Visual COBOL ships with Eclipse 3.8 but also supports Eclipse 4.2
and 4.3 (the 32-bit IDE only). To use Visual COBOL with a newer version of Eclipse, you need to install
Visual COBOL first and then use the installeclipseplugins.bat script in
%ProgramFiles(x86)%\Micro Focus\Visual COBOL\installer (Windows) or
installeclipseplugins script in /opt/microfocus/VisualCOBOL/installer (UNIX). See
Installing into other instances of Eclipse for more details.

• Remote JVM COBOL projects - this release provides enhanced support for remote JVM COBOL
projects.

• Remote project connections - the diagnosis tool for remote connection issues has been improved.
There is now a client-side diagnosis tool and a server-side diagnosis tool for diagnosing connection
problems to remote projects and connections to your Micro Focus Visual COBOL Development Hub.
You should run both tools for a complete diagnosis.

Character set enhancements
The following character sets, available using the MFCODESET environment variable, have been enhanced
or added in this release:

• Thai Extended (0066) - new
• Korean (0082)
• Simplified Chinese (0086)
• Traditional Chinese (0886)

There are also a number of double-byte character sets that are now capable of mixed single-byte and
double-byte character conversion; see the definition of MFCODESET in Environment Variables in
Alphabetical Order for more information.

Code Analysis
Code Analysis helps you understand and optimize your COBOL applications. This release of Visual
COBOL provides Dead Code analysis.

Database Access
The following new features have been added as part of database access support:

COBSQL The new KEEPCOMP directive resolves COMP/COMP-5 issues with Oracle applications
on little-endian platforms.
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DB2 This release introduces a new DB2 ECM compiler directive option, GEN-HV-FROM-
GROUP, that generates host variables for all elementary data items when a multiple-level
group variable is used in a FETCH or singleton SELECT DB2 statement.

OpenESQL This version provides the following new OpenESQL features:

SQL Server Support for SQL Server 2014.

SQL compiler
directive
options

The following are new SQL compiler directive options:

DETECTDATE=SERVER Resolves host variables alignment with
column data types in an SQL table.

GEN-HV-FROM-GROUP Generates host variables for all
elementary data items when a
multiple-level group variable is used in
a FETCH or singleton SELECT SQL
statement.

Sample
applications

The following native COBOL SQL sample applications are new with
this version:

Get Diagnostics Demonstrates how to use GET DIAGNOSTICS
EXEC SQL calls to get diagnostic information
from various DBMSs.

LOB Data Types Demonstrates how to INSERT and SELECT
LOB data in a native application using various
DBMSs.

XA switch
modules

Restriction: This feature applies only when the Enterprise Server feature is
enabled.

The Oracle (Windows and UNIX platforms) and SQL Server (Windows platforms only) XA
switch modules are now compiled with one source file rather than two.

Micro Focus COBOL enhancements
The following enhancements have been made to Micro Focus COBOL:

• The following phrases have been added to the XML GENERATE statement:

• NAME
• TYPE
• SUPPRESS

• The following intrinsic functions have been added:

• ULENGTH
• UPOS
• USUBSTR
• USUPPLEMENTARY
• UVALID
• UWIDTH
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External Security Facility (ESF)
The Enterprise Server External Security Facility (ESF) now supports caching the results of some security
queries. This can improve the performance of enterprise server instances and of the MFDS when they are
configured to use external security.

To enable caching, you need to set non-zero values for the Cache limit (maximum size of the cache) and
Cache TTL (Time To Live, or how long before a cached result expires) settings on the MFDS Security tab,
the Default ES Security tab, or on the Security tab for an individual enterprise server. (Currently, the
cache settings for Security Managers have no effect; you need to set cache parameters on one of the three
Security pages mentioned earlier.)

For more information, see http://supportline.microfocus.com/examplesandutilities/doxygen/caching.html.

New tunables
The following tunables have been added in this release:

reduce_java_signals This tunable specifies the options that are passed to a JVM when mixing Java and
COBOL.
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Known Issues
Refer to the Known Errors and Restrictions topic in the Product Information section of your product Help.

In addition, note the following:

COBOL
Watchpoints

The debugger ignores a COBOL watchpoint that is hit if there is no statement
following the statement that modifies the data on which that watchpoint is set.

Debugging There is an issue with "Wait for attachment" when you use Visual COBOL for Eclipse
to debug applications that run on some UNIX/Linux platforms. Eclipse connects to the
debugger on the remote machine, but might not attach to the process to debug the
code.

To work around this issue, ensure that on the remote machine the TMPDIR
environment variable is unset or has the same value for both Micro Focus Visual
COBOL Development Hub server and for the running process you wish to debug. The
Micro Focus Visual COBOL Development Hub server is the server which you started
either directly with the $COBDIR/remotedev/startrdoserver script or indirectly using
the daemon which is started with the $COBDIR/remotedev/startrdodaemon script.

To check the variable used by the Micro Focus Visual COBOL Development Hub
server:

1. Open Remote Systems view in Eclipse on the Windows machine.
2. Right-click the Shells element of the server connection to be tested and click

Launch Shell.
3. In the Remote Shell view, type echo $TMPDIR in the Command field, and press

Enter.

The value of the TMPDIR environment variable is shown - ensure it is the same as
the one used by the process to be debugged.

Note: The value of TMPDIR used by the Development Hub server cannot be
changed in the remote shell and must be set before you start the daemon or
server.

Documentation • A problem in Visual COBOL results in an error when you try to submit the JCL file
as described in the tutorial Getting started with Visual COBOL for Eclipse in the
product help. To work around this, when you follow the steps in the topic Importing
the BankDemo project and adding the source files, execute the step Setting
Compiler directives before executing the step Specifying the copybook paths for
the project. This ensures the BankDemo projects is rebuilt. The instructions have
been updated in the Micro Focus Infocenter version of the help.

• A known issue in JRE 1.7.0_45 (issue JDK-8028111) causes problems with
searching and indexing the help in the Eclipse help viewer if you are running
Eclipse on a machine that has this version of JRE installed.

Database
Access

If you have a remote COBOL project under Eclipse that uses DB2 ECM in Visual
COBOL or HCO for DB2 LUW in Enterprise Developer and the DB2 software is not
installed on the client machine where you are using the Eclipse IDE, you receive
background parsing errors in your application. To resolve the issue, you can do either
one of the following:
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• Disable background parsing Window > Preferences > Micro Focus > COBOL >
Editor and disabling the checkbox for Background parsing.

• Install the IBM DB2 client-side software on the machine on which you are running
Eclipse. Go to the IBM Support Home and locate the page entitled "IBM Download
Fix Packs for IBM Data Server Client Packages" .

Enterprise
Server

• The Historical Statistics Facility may generate incorrect records for SSTM-enabled
enterprise servers.

ICETOOL
Emulation

ICETOOL emulation for managed code is not available in this release.

Installation • Before installing this release as an upgrade to an existing installation of the
previous version 2.2 of the product, you must uninstall any HotFixes of 2.2. This is
to avoid some problems that might result in files not being installed. This is
required only on Windows.

• Before installing this release as an upgrade, ensure you create a back-up of your
Enterprise Server configuration. To do this, on the Enterprise Server Administration
home page, click Export and then select Export Enterprise Server configuration
and Security Manager definitions. This creates a backup folder in the c:
\programdata\micro focus\Enterprise Developer\MFDS. You can
restore the Enterprise Server configuration after installing this release - click Import
on the Enterprise Server Administration home page.

• On UNIX, check UNIX Installer Issues before you start the installation.

Resource
Adapters

Trying to deploy the local resource adaptor mfcobol-localtx.rar to WebLogic
may fail with a ClassCastException. To work around this issue, you need to deploy
mfcobol-xa.rar first, then need to undeploy this file and deploy the local one,
mfcobol-localtx.rar. If there are issues deploying using the WebLogic GUI, you
can use the command line. If there are issues with this as well, try reducing the length
of the command (for example, by moving the file to a location with a shorter path).
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Significant Changes in Behavior or Usage
This section describes significant changes in behavior or usage. These changes could potentially affect the
behavior of existing applications or impact the way the tools are used.

The numbers that follow each issue are the Support Incident Numbers followed by the Reported Problem
Incident (RPI) number (in parentheses).

• Compiler
• Compiler Front-end
• Documentation
• J2EE Connector

Compiler

Back to the list

• When using the HOSTRW directive with the mainframe dialect, Report Writer will now produce the full
range of ASA control characters and will emulate mainframe print files.

2697615 (1094527)

Compiler Front-end

Back to the list

• Fixed Binary (p<=7) is now an 8-bit, signed, 2's complement binary integer by default.

Documentation

Back to the list

• The default setting for the MFALLOC_PCFILE environment variable has changed; the default is now set
to Y, which means that when cataloguing a file that has a DCB attribute of DSORG=PS, a physical file is
created for it if one does not exist. Previously, the default was set to N, which meant that a file was not
created.

2697571 (1094370)

J2EE Connector

Back to the list

• The listSystem.properties file in package com.ibm.ctg.client was missing documentation for some
sections.

(606556)
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Resolved Issues
The numbers that follow each issue are the Support Incident Numbers followed by the Reported Problem
Incident (RPI) number (in parentheses).

• Adis
• Animator (Character version)
• CAS (COBOL App Server) General
• CAS Admin Console
• CAS Security
• CAS XA Switch modules
• CCI TCP/IP
• Compiler
• Codeset Support
• Data Tools Converter
• Data Tools Layouts
• Documentation
• Enterprise Analyzer Integration
• Eclipse IDE
• ES Cluster
• File Handling: External File Handler
• HCO for Microsoft SQL Server
• JVM: Compiler
• JVM: Run-Time System
• MF Communications Server
• MF Directory Server
• MFA Server
• MFA SyncMon
• MFBSI
• MFIO
• NCG
• OO Run-Time System (32-bit)
• Run-Time System
• Setup Issues
• SQL: Cobsql
• SQL: DB2 ECM
• SQL: HCO for SQL Server
• SQL: OpenESQL
• Unassigned
• Web Service Client
• XML syntax support runtime

Adis

Back to the list

• When using X"AF" function 81, screen attributes are now inherited correctly.

2782580 (1094878)
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• Using an ACCEPT statement followed by a display of an OUTPUT RIGHT item and an ERASE EOL
item no longer causes a corruption of a screen section.

2695444 (1093924)

Animator (Character version)

Back to the list

• Programs compiled with the CHARSET(EBCDIC) Compiler directive now show the correct values for
Query in the Animator.

2780466 (1094644)

CAS (COBOL App Server) General

Back to the list

• Using the INPUTMSG parameter for the XCTL and LINK commands is now working correctly.

2790518 (1095805)
• On user syncpoint, a 500-error no longer returns to the client if the application did not issue a WEB

SEND.

2780958 (1094671)
• When linking to a program with a channel, the current channel was not always honoured.

2779977 (1094556)
• Enterprise Server is not longer sending a FREEKB to the terminal at the end of a task when there is

more work pending for the terminal.

2691707 (1093544)
• You no longer receive an intermittent signal 11 in MFCS during shutdown.

CAS Admin Console

Back to the list

• When starting an enterprise server instance, the location of the work files may differ depending on
whether the instance was started using a browser or from the command line. See the documentation for
"system directory" in the topic "Server Instance Properties General".

2660616 (1090612)

CAS Security

Back to the list

• The es-ldap-update.cmd script has been updated for the Visual COBOL product line. The script is used
to install a sample set of security definitions when LDAP-based security is used with Enterprise Server.

CAS XA Switch modules

Back to the list

• When using HCOSS, if a global temporary table is declared twice, the current transaction will no longer
be implicitly rolled back.

2780353 (1094629)
• HCOSS concurrency issues with DECLAREd GLOBAL TEMPORARY TABLEs have been resolved. As

a result, in this release we no longer support user-defined (i.e., persistent) tables in the SESSION
schema.

2697852 (1094184)
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• EXEC SQL RESET CONNECTION has been updated and is used to drop Global Temporary Tables at
the end of tasks.

2693269 (1093613)
• EXEC SQL SYNCPOINT has been updated and now correctly handles ON COMMIT actions for

DECLAREd global temporary tables.

2682648 (1093611)

CCI TCP/IP

Back to the list

• CCITCP client connections could intermittently fail on some platforms due to transient errors in the
TCP/IP stack. CCITCP is now more aggressive at detecting and retrying client connections under these
conditions. This primarily affects COBOL Web services clients, some Enterprise Server command-line
utilities, and Fileshare clients.

2794263 (1096355)
• INT and CSO modules that use the Casfile API can now successfully connect to SSL-secured

Enterprise Server listeners.

2696022 (1094318)

Compiler

Back to the list

• Programs with a mainframe dialect that contain a paragraph declaration that is not preceded by a period
and that is previously referenced now compile as expected.

2793046 (1096112)
• Complex table VALUE syntax is now working as expected.

2792013 (1095954)
• Compilation no longer hangs when REPLACE and COPY REPLACING is active and the source code

has multiple lines ending in a comma.

2791425 (1095905)
• READ and WRITE statements with the RM filehandler for files defined with the "RECORD VARYING

FROM 0 TO ..." syntax now behave as expected.

2785986 (1095385)
• An INSPECT CONVERTING statement on a subscripted sliding item now executes as expected.

2785328 (1095244)
• Setting the LINE-COUNT(2) Compiler directive on a project no longer causes the IDE to crash during a

background syntax check.

2784751 (1095114)
• Data items with DBCS characters which are defined as SQL data types are now processed correctly.

2783799 (1094976)
• The OSEXT and COPYEXT directives now work with quoted names (with or without spaces).

2780350 (604653)
• Compiling programs that use both the "WITH DEBUGGING MODE" and "IS INITIAL" clauses now

produces correct object code.

2779266 (1094498)
• Programs that use an external report file now execute as expected.

2698699 (1094352)
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• The performance of the syntax constructs "SET ADDRESS OF .. TO ADDRESS OF ..." when using the
AMODE compiler directive has been improved.

2697051 (1094174)
• Using the "Determine Directives" command on a source file that has an asterisk in column one (which is

not a Micro Focus-style comment) now returns results as expected.

2696946 (1094680)
• A MOVE of 'ALL <alphanumeric literal>' to a numeric display item is now correctly emulated under

DIALECT(RM).

2648551 (1089534)
• The IDE now correctly indicates the location of errors in multi-program source.

2541308 (1081744)
• Using Watch/Quick Watch on a data item with subscripts, where one of the subscripts is also

subscripted, now produces the correct results.

2463792 (1075281)
• A program that exceeds the system limit of 254 DETAIL groups for a report now receives an appropriate

error message "COBCH1692S Too many DETAIL groups specified for report".

2458349 (1096071)

Codeset Support

Back to the list

• The offset of input segments is now calculated correctly. In order to apply the fix, you must regenerate
the MFS source.

2695463 (1093948)

Data Tools Converter

Back to the list

• Converting a data file using record layouts will now report an error if a field within the selected record
layout exceeds the length of the data file record being converted.

2699617 (1094446)
• The GUI data file converter no longer terminates data item conversion prematurely when using a record

layout with an ODO data item.

2692803 (1093839)

Data Tools Layouts

Back to the list

• Creating a record or a segment layout file no longer fails when the COBOL names contain double-byte
characters.

Documentation

Back to the list

• The documentation for the MFBSI CTF trace option has been corrected in the online help. It now reads:
mftrace.comp.mfbsi.emx#all = true

2693323 (1093631)
• The description for the MULTI-NESTED topic under DB2 Compiler Directive Options was incorrect.

2783274 (1094953)
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• The topic about the ILSMARTLINKAGE Compiler directive in the product help now includes information
about the get_Reference() method (JVM COBOL) and the .Reference property (.NET COBOL) that the
classes and types generated with ILSMARTLINKAGE produce. If you pass such a class or type as a
parameter to a program that receives it "by reference”, you need to use the "by reference" object by
specifying the get_Reference() method or .Reference property, respectively. This returns an object that
encapsulates the ILSMARTLINKAGE parameter so it be used with a method that is declared as "by
reference". You also need to use get_Reference() or .Reference with the RunUnit:Call() method.

2779516 (1094514)
• The product help now includes an overview of the Eclipse IDE in Welcome > Introduction to Eclipse

and provides information about how Working Sets work - when you are have enabled a Working Set,
Eclipse performs a full build of the projects that are part of that working set or have a file that is part of
the working set.

2694881 (1094169)
• The setup file installs the product and any missing third party software, and will install the Java 7

Update 27. This information is now included in the Software Requirements section of the product help.

2785427 (1095199)
• The setup file installs the product and any missing third party software, and will install the .NET

Framework v4.0. This information is now included in the Software Requirements section of the product
help.

2672774 (1095057)

Enterprise Analyzer Integration

Back to the list

• An issue with the DISPLAY ... LINE statement being unable to process expressions has been fixed.

Eclipse IDE

Back to the list

• Executing the "Determine Directives" command on a project with a build configuration that has the
"Override project COBOL settings" option enabled now sets the dialect at both build configuration and
project level.

2790210 (1095782)
• The IDE now prevents adding remote folders as linked folders to a remote project unless both the

folders and the project are on the same connection. For samba-style projects, it is not possible to map
the project to the samba drive.

2789973 (1096026)
• When importing a Net Express project which has multiple INT and GNT targets into Eclipse, the IDE no

longer creates separate projects for each INT or GNT target. Eclipse now creates a single project for all
INT/GNT targets and will appropriately select or deselect the file-specific option to generate the .gnt file.

2789861 (1095749)
• When running or debugging a project, the Console Size settings on the Run-time Configuration page

within the project's properties was ignored.

2786714 (1095307)
• You can specify additional object files when linking an application and when the Eclipse build

configuration output path is set to a linked directory.

2781741 (1094863)
• You no longer receive a "Graphic is disposed" error when opening a COBOL file from a CA SCM/

Harvest.

2779498 (1094643)
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• You no longer receive error messages for missing copybook files in COBOL projects if they reference
COBOL Copybook projects that are stored in a Jazz source control system.

2697816 (1094507)
• If a COBOL project is specified in a debug launch configuration, the IDE will only build this project and

its referenced projects before launching the configuration. Previously, the IDE performed a full rebuild of
all projects in the workspace except when you launched a project as part of a COBOL Application
configuration that had the "Program is part of project build configuration" option checked.

2695131 (1093912)
• It is now possible to build JVM projects on remote machines and to use 64-bit JREs to launch COBOL

JVM classes.
• This release provides support for remote JVM COBOL projects and for launching the output classes

using a 64-bit JRE.

ES Cluster

Back to the list

• In a clustered configuration of Enterprise Server, on some platforms, MFCS could crash during startup
of an enterprise server instance due to attempting to process communications with the cluster manager
before initialization was complete.

File Handling - External File Handler

Back to the list

• An automatic close of a file opened in a container no longer causes a rollback.

2790362 (1095956)
• Previously, a file could be left with its integrity bit set to transactional if a process included a mix of

transactional and non-transactional opens and the last close of the file was a non-transactional one.

2785682 (1095657)
• The transaction log now correctly shows the timestamp for the prepare, commit and rollback operations.

2784948 (1095162)
• If a VSAM file is opened for an OUTPUT in a RANDOM/DYNAMIC access mode, the file virgin state is

changed to a non-virgin even if no records are written to it. If the file is opened for an OUTPUT in a
SEQUENTIAL access mode, its virgin state is retained.

2781975 (1094779)
• The MFALLOC_PCFILE environment variable now works as expected. Previously, it would be bypassed

when the ES_ALLOC_OVERRIDE environment variable was also specified.

2692290 (1093977)
• During Open OUTPUT of a VSE VSAM reusable file, with DISP=OLD, the file is no longer reset; the file

is opened in EXTEND mode.

2638640 (1089073)

HCO for Microsoft SQL Server

Back to the list

• When trying to compile an OpenESQL program with an invalid combination of the BIND ACCESS and
DBRMLIB Compiler directives, you now receive an error message.

2694907 (1093864)
• The HCOSS Data Transfer tool now supports SQL Server 2014. The executable for SQL Server 2014

for the command line is: mfdatatransferctlr14.exe.
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JVM - Compiler

Back to the list

• The INSPECT CONVERTING statement, when applied to DBCS data, now produces the expected
results when compiling to JVM COBOL.

2784715 (1095080)
• A STRING statement that has contiguous literal operands with a total length of more than 8192 bytes no

longer causes system errors during compilation.

2700765 (1094513)
• When compiling JVM COBOL, moving subscripted operands to multiple targets now works as expected.

2695442 (1093923)
• Previously, with JVMGEN on, the Compiler was failing to compile a program that includes a working-

storage section with a very large number of VALUE clauses. Although this may still happen in some
cases, the incidence of problem programs has been greatly reduced.

2693676 (1094165)

JVM - Run-Time System

Back to the list

• Previously, when compiling an application with the JVMGEN Compiler directive and the application
included a large number of "value" clauses in the working-storage section, the "value" clauses were not
always.

2784025 (1095274)
• Negative single digit results no longer evaluate to zero.

2696486 (1094062)

MF Communications Server

Back to the list

• Certain Enterprise Server administration actions such as notifying a running enterprise server of a
security update could cause MFCS to hang.

2784219 (1095045)

MF Directory Server

Back to the list

• The Enterprise Server Administration no longer terminates when trying to display a list of users
registered on an external Security Manager.

2788461 (1095505)
• The 64-bit MFDS is now able to read and write XML configuration data.

MFA Server

Back to the list

• This release provides a fix for abend 0C4 in XDBWWWM0.

MFA SyncMon

Back to the list
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• Previously, PDS members without ISPF statistics caused an error message "Input string was not in a
correct format" when processing the timestamp. Now the current time is used. SyncMon2 also
downloads the entire PDS every time.

2783738 (1094996)
• The product now displays a useful error message and not an exception when a user specifies an illegal

output.
• Removing a rule from the SM2 dialog no longer causes other rules to be removed from the dialog.

MFBSI

Back to the list

• Support has been added for the Control-M $JULIAN/$GREG/$WEEK# functions using the Control-M
expression or variable parameters.

2698531 (1094301)

MFIO

Back to the list

• Specifying a leading ";" in an environment variable containing a file path no longer results in the file not
being found.

2693286 (1093707)

NCG

Back to the list

• Using a "MOVE alphanumeric-item to numeric-item" statement in programs generated with the
CHECKNUM directive now correctly results in a Run-Time System error 163 (invalid numeric data)
message.

2796191 (1096340)
• Building programs that use DIALECT(RM) and that contain calls with more than eight parameters no

longer fails with a RTS 114 error.

2788746 (1095583)
• An issue with statements of type "compute edited-item = expression", where expression evaluates to a

value larger than the value that edited-item can store, and so truncation is required, has been fixed. This
only affected Intel x86 32-bit generated code when the HOSTARITHMETIC Compiler directive was set.

2782400 (1094841)
• Compiling code that contains alphanumeric intrinsic functions with very long parameters could

previously result in an error at generate time. It now generates successfully.

2782306 (1094942)
• A bug in the MOVE statement where the source item is S9(15)V99 COMP-3 and the target item

S9(8)V9(9) comp-3 has been fixed.

2697129 (1094607)
• The performance of arithmetic with COMP-3 items on the 390 platform has been greatly improved.

2683340 (1092877)
• Programs that include 8-byte comp/comp-5 variables in a PERFORM loop termination condition, with

the OPT Compiler directive specified, now compiles successfully in 32-bit mode.
• An issue with the code generated for alphanumeric moves on Intel x86-32 when the OPT(4) Compiler

directive was specified has been fixed.
• You no longer receive an RTS 114 error when processing invalid directives.
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• You no longer receive an RTS 200 error in debuggable generated code (.gnt) programs compiled with
the amode(31) Compiler directive.

• A problem with setting breakpoints on some EXEC SQL statements has been fixed.

OO Run-Time System (32-bit)

Back to the list

• Native object-oriented programs with multiple methods that use local-storage data now execute as
expected.

Run-Time System

Back to the list

• You can now use a configuration file that has a spacey filename to start Audit Manager as a service.

2785459 (1095200)
• The debugger now displays correctly the content of non-ASCII characters in programs compiled with the

CHARSET(EBCDIC) Compiler directive.

2782246 (1094947)
• In some situations, the processing of a Run-Time System error in an Enterprise Server container could

cause the container to hang or crash. This has been fixed.

2690883 (1094783)

Setup Issues

Back to the list

• The mfsupport permissions have been modified so that any user with access to the product can now
run mfsupport.

2781319 (1094713)

SQL: Cobsql

Back to the list

• COBSQL now correctly processes source lines that only contain a single character at column 72.

2781493 (1094727)
• COBSQL now correctly processes SQL statements with continuation lines.

2781299 (1094716)

SQL: DB2 ECM

Back to the list

• A new directive option, DB2(ALEBRA), has been added to the DB2 ECM preprocessor to prevent
ASCII/EBCDIC translation of host variables used in SQL statements. DB2(ALEBRA) is applicable only
when using the EBCDIC character set and the Alebra Remote DB2 Access software.

2789897 (1095736)
• Programs using SQL TYPE AS CLOB compiled with host variables were flagged with COBCH0233S

Compiler error because the reserved word "AS" is not supported in mainframe dialects such as
Enterprise COBOL. The DB2 pre-compiler now resolves this by adding "AS" as a valid reserved word.

2698988 (1094584)
• While editing the source code in the IDE during syntax checking, the DB2 pre-compiler sometimes

generated incorrect error messages for DECLARE CURSOR statements if they were defined in the
WORKING-STORAGE section when the DB2 BACKGROUND PARSING option was set to NONE.
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2698133 (1094267)
• COMP-3 host variables prevented the porting of JVM COBOL object code between machines with

different byte ordering architectures.

2695871 (1094325)

SQL: HCO for SQL Server

Back to the list

• SQL decimal result columns with a maximum precision of 38 could not be retrieved.

2698172 (1094215)
• The HCOSS data conversion tool did not support mainframe DB2 tables and corresponding indexes

that were created under different schemas.

2696111 (1094539)
• HCOSS did not correctly extract mainframe syssequence table entries with MAXVALUE greater than 31

digits.

2696106 (1094067)
• When HCOSS converts DB2 TIME() functions, the seconds component will now be truncated rather

than rounded in order to match mainframe behavior.

2692917 (1093579)
• HCOSS now supports DB2 multi-row INSERT statements.

2683979 (1094036)

SQL: OpenESQL

Back to the list

• The OpenESQL preprocessor incorrectly terminated a host variable lookup resulting in a COBES0109
error.

2795391 (1096265)
• Using a SQL Server fast forward cursor with an ODBC driver that does not support MARS caused a

rollback when the cursor was closed.

2793798 (1096126)
• Applications migrated from earlier products that used the tokens ON and ROW_NUMBER as column

names in SQL statements were compiling with errors.

2793301 (1096088)
• The OpenESQL preprocessor produced a compilation error for EXEC SQL select ... INTO

<TableName> ... END-EXEC.

2792715 (1096102)
• The OpenESQL runtime for ADO.NET was incorrectly returning the native database error in

SQLERRD(1).

2790152 (1095758)
• A problem fetching decimal columns using OpenESQL for ODBC in locales where the decimal point is

not '.' has been fixed. In addition, to optimize performance for the majority of ODBC applications, the
default setting for SQL(DECDEL) has been changed from NODECDEL to DECDEL=LOCAL. Use an
explicit SQL(NODECDEL) directive for Windows applications that change the effective locale
dynamically at runtime.

2788986 (1095766)
• The insertion of values larger than 8000 characters from a PIC X host variable into a SQL Server

VARCHAR(MAX) column caused an error.

2787574 (1095428)
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• Some valid ODBC SQL expressions caused the OpenESQL preprocessor to issue errors when it
encountered a 'BY' token.

2787068 (1095429)
• Valid SQL "PARTITION BY" clauses caused compiler errors when using OpenESQL.

2786991 (1095386)
• Performance of the OpenESQL runtime system for ODBC required improvement when fetching

character data.

2785410 (1095165)
• The OpenESQL preprocessor generated invalid code resulting in undefined ECM error code 302 when

an array host variable was mixed with regular host variables in a parameter list in the EXEC SQL CALL
statement.

2785284 (1095354)
• A memory leak occasionally occurred when multiple prepares of the same dynamic SQL statement

existed in the OpenESQL JDBC runtime system.

2784039 (1095123)
• The OpenESQL preprocessor incorrectly interpreted the SQL CONCAT character as DBCS when using

SQL(CONCAT=124) for the CONCAT character, resulting in compilation error.

2783615 (1094981)
• When compiling for ODBC, the OpenESQL preprocessor now generates an error message,

COBES0123, when it encounters an EXEC SQL statement that contains a host or indicator variable that
uses a subscript. Subscripts of this type are not supported in ODBC.

2781022 (1094686)
• The GEN-HV-FROM-GROUP SQL compiler directive option intermittently caused truncation of SQL

VARCHAR data type occurrences.

2780748 (1094649)
• SQL(CHECK) caused compilation errors when compiling source programs containing DBCS characters

in column names. Programs containing DBCS characters in column names that were compiled using
SQL(NOCHECK) caused runtime errors.

2780185 (1094588)
• The GEN-HV-FROM-GROUP compiler directive option has been added to the OpenESQL preprocessor

to support the selection of multiple levels in a group item. Specify SQL(GEN-HV-FROM-GROUP) when
compiling to generate host variables for each elementary definition in a group record.

2699622 (1094395)
• OpenESQL for JDBC did not correctly open insensitive cursors.

2699442 (1094415)
• OpenESQL Assistant was inconsistently inserting the query function in the "B" area for queries and

column 8 for other code.

2697908 (1094190)
• The OpenESQL preprocessor sometimes incorrectly defined host variables when an indicator variable

array was used with an SQL statement.

2696332 (1094052)
• You no longer receive errors when parsing Oracle INTERVAL expressions.

2694071 (1094337)
• A problem that prevented a COBOL stored procedure from being called from a nested trigger has been

fixed.

2690749 (1094042)
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• The restriction that program names in an application must be unique in the first 24 characters in order
for OpenESQL to handle cursors correctly has been increased to 30 characters. This is to restore
backwards compatibility with earlier Micro Focus products.

2685901 (1093808)
• HCOSS now provides better control for ODBC applications that use data that: o Uses the DATE and

TIME formats specified by SQL(DATE) and SQL(TIME) o Is stored as character data in the database
You can now do any of the following: o Specify host variable types to use with DETECTDATE. o Set the
ODBC runtime to determine parameter data types by querying the server (this option uses additional
runtime overhead). o Tag string literals in SQL statements with special SQL comments that specify the
type of literal. With this option, literals tagged with /*#CHAR*/ are not reformatted when
SQL(DIALECT=MAINFRAME) is set.

2685625 (1093540)

Unassigned

Back to the list

• A channel created by a program invoked by a CALL statement is now visible to the programs running at
the same level.

2698335 (1094225)

Web Service Client

Back to the list

• Namespaces not declared on the schema root, i.e. declared either with an element declaration or on the
WSDL root, will now be processed properly and no longer ignored.

2583853 (1085102)

XML syntax support runtime

Back to the list

• The HTMLPP preprocessor now handles copybooks with filenames longer than eight characters
correctly.

2783315 (1095092)
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Updates and SupportLine
Our Web site gives up-to-date details of contact numbers and addresses.

Further Information and Product Support
Additional technical information or advice is available from several sources.

The product support pages contain a considerable amount of additional information, such as:

• The WebSync service, where you can download fixes and documentation updates.
• The Knowledge Base, a large collection of product tips and workarounds.
• Examples and Utilities, including demos and additional product documentation.

To connect, enter http://www.microfocus.com in your browser to go to the Micro Focus home page.

Note: Some information may be available only to customers who have maintenance agreements.

If you obtained this product directly from Micro Focus, contact us as described on the Micro Focus Web
site, www.microfocus.com. If you obtained the product from another source, such as an authorized
distributor, contact them for help first. If they are unable to help, contact us.

Information We Need
However you contact us, please try to include the information below, if you have it. The more information
you can give, the better Micro Focus SupportLine can help you. But if you don't know all the answers, or
you think some are irrelevant to your problem, please give whatever information you have.

• The name and version number of all products that you think might be causing a problem.
• Your computer make and model.
• Your operating system version number and details of any networking software you are using.
• The amount of memory in your computer.
• The relevant page reference or section in the documentation.
• Your serial number. To find out these numbers, look in the subject line and body of your Electronic

Product Delivery Notice email that you received from Micro Focus.

On Windows, if you are reporting a protection violation you might be asked to provide a dump ( .dmp) file.
To produce a dump file you use the Unexpected Error dialog box that is displayed when a protection
violation occurs. Unless requested by Micro Focus SupportLine, leave the dump setting as Normal
(recommended), click Dump, then specify a location and name for the dump file. Once the dump file has
been written you can email it to Micro Focus SupportLine.

Alternatively, you might be asked to provide a log file created by the Consolidated Tracing Facility (CTF) - a
tracing infrastructure that enables you to quickly and easily produce diagnostic information detailing the
operation of a number of Micro Focus software components.

On UNIX, you can use the Micro Focus UNIX Support Scan Utility, mfsupport, to create a log file that
contains the details about your environment, product, and settings. The mfsupport script is stored in
$COBDIR/bin.

To run mfsupport:

1. Start a UNIX shell.
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2. Set COBDIR to the product with issues.
3. Execute mfsupport from a directory where you have write permissions.

This creates a log file, mfpoll.txt, in that directory.
4. When the script finishes, send the mfpoll.txt file to your Micro Focus SupportLine representative.

Note:

If COBDIR is set to a location that does not contain etc/cobver, the script outputs the contents
of /opt/microfocus/logs/MicroFocusProductRegistry.dat which keeps a list of the
installed Micro Focus products.

Creating Debug Files
If you encounter an error when compiling a program that requires you to contact Micro Focus SupportLine,
your support representative might request that you provide additional debug files (as well as source and
data files) to help us determine the cause of the problem. If so, they will advise you how to create them.
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Disclaimer
This software is provided "as is" without warranty of any kind. Micro Focus disclaims all warranties, either
express or implied, including the warranties of merchantability and fitness for a particular purpose. In no
event shall Micro Focus or its suppliers be liable for any damages whatsoever including direct, indirect,
incidental, consequential, loss of business profits or special damages, even if Micro Focus or its suppliers
have been advised of the possibility of such damages. Some states do not allow the exclusion or limitation
of liability for consequential or incidental damages so the foregoing limitation may not apply.

Micro Focus is a registered trademark.

Copyright © Micro Focus 1984-2014. All rights reserved.
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